PC Control type

Please read this manual before using the machine.
Please keep this manual within easy reach for quick reference.

NINE NEEDLE ONE HEAD EMBROIDERY MACHINE
TWELVE NEEDLE ONE HEAD EMBROIDERY MACHINE
Thank you very much for buying a BROTHER sewing machine. Before using your new machine, please read the safety instructions below and the explanations given in the instruction manual.

With industrial sewing machines, it is normal to carry out work while positioned directly in front of moving parts such as the needle and thread take-up lever, and consequently there is always a danger of injury that can be caused by these parts. Follow the instructions from training personnel and instructors regarding safe and correct operation before operating the machine so that you will know how to use it correctly.

### SAFETY INSTRUCTIONS

#### 1 Safety indications and their meanings

This instruction manual and the indications and symbols that are used on the machine itself are provided in order to ensure safe operation of this machine and to prevent accidents and injury to yourself or other people. The meanings of these indications and symbols are given below.

<table>
<thead>
<tr>
<th>Indications</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DANGER</strong></td>
<td>The instructions which follow this term indicate situations where failure to follow the instructions will almost certainly result in death or severe injury.</td>
</tr>
<tr>
<td><strong>CAUTION</strong></td>
<td>The instructions which follow this term indicate situations where failure to follow the instructions could cause injury when using the machine or physical damage to equipment and surroundings.</td>
</tr>
</tbody>
</table>

---

**Symbols**

- **This symbol ( △ ) indicates something that you should be careful of.**
  - The picture inside the triangle indicates the nature of the caution that must be taken. (For example, the symbol at left means "beware of injury").

- **This symbol ( ☞ ) indicates something that you must not do.**

- **This symbol ( ○ ) indicates something that you must do.**
  - The picture inside the circle indicates the nature of the thing that must be done. (For example, the symbol at left means "you must make the ground connection").
2 Notes on safety

**DANGER**

Wait at least 5 minutes after turning off the power switch and disconnecting the power cord from the wall outlet before opening the face plate of the control box. Touching areas where high voltages are present can result in severe injury.

**CAUTION**

**Environmental requirements**

- Use the sewing machine in an area which is free from sources of strong electrical noise such as high-frequency welders. Sources of strong electrical noise may cause problems with correct operation.
- Any fluctuations in the power supply voltage should be within ±10% of the rated voltage for the machine. Voltage fluctuations which are greater than this may cause problems with correct operation.
- The ambient temperature should be within the range of 5°C to 35°C during use. Temperatures which are lower or higher than this may cause problems with correct operation.
- The relative humidity should be within the range of 45% to 85% during use, and no dew formation should occur in any devices. Excessively dry or humid environments and dew formation may cause problems with correct operation.
- Avoid exposure to direct sunlight during use. Exposure to direct sunlight may cause problems with correct operation.
- In the event of an electrical storm, turn off the power and disconnect the power cord from the wall outlet. Lightning may cause problems with correct operation.
- Do not use this machine outdoors.

**Installation**

- Machine installation should only be carried out by a qualified technician.
- Never operate the sewing machine with any ventilation openings blocked.
- Keep the ventilation openings of the sewing machine free from the accumulation of lint or dust.
- Contact your Brother dealer or a qualified electrician for any electrical work that may need to be done.
- The sewing machine weighs approximately 195 kg. The installation should be carried out by two or more people.
- Do not connect the power cord until installation is complete, otherwise the machine may operate if the start switch is pressed by mistake, which could result in injury.
- Be sure to connect the ground. If the ground connection is not secure, you run a high risk of receiving a serious electric shock, and problems with correct operation may also occur.
- When securing the cords, do not bend the cords excessively or fasten them too hard with staples, otherwise there is the danger that fire or electric shocks could occur.
- Be sure to wear protective goggles and gloves when handling the lubricating oil or grease, so that no oil or grease gets into your eyes or onto your skin, otherwise inflammation can result. Furthermore, do not drink the oil or grease under any circumstances, as they can cause vomiting and diarrhoea. Keep the oil out of the reach of children.
- Secure the machine with the adjustment bolts on the sound floor so that it will not move.
### Installation

Avoid setting up the sewing machine near sources of strong electrical noise such as high-frequency welding equipment. If this precaution is not taken, incorrect machine operation may result.

### CAUTION

#### Sewing

- This sewing machine should only be used by operators who have received the necessary training in safe use beforehand.
- Keep children away from the sewing machine.
- The sewing machine should not be used for any applications other than sewing.
- Be sure to wear protective goggles when using the machine. If goggles are not worn, there is the danger that if a needle breaks, parts of the broken needle may enter your eyes and injury may result.
- Always use the proper needle plate. Any wrong plate can cause needles to break.
- Do not use a bent needle.
- Turn off the power switch at the following times, otherwise the machine may operate if the start switch is pressed by mistake, which could result in injury.
  - When threading the needle
  - When replacing the bobbin and needle
  - When not using the machine and when leaving the machine unattended
  - When cleaning the machine.
- Do not get on the table. Table may be damaged.
- Do not operate this machine where aerosol (spray) products are being used or where oxygen is being administered.
- Attach all safety devices before using the sewing machine. If the machine is used without these devices attached, injury may result.
- Do not touch any moving parts, press any objects against the machine, or pull/push the cloth during sewing. Doing so may result in personal injury, machine damage, or needle breakage.
- Do not touch the pulse motor and sewing machine bed section during operation or for 30 minutes after operation. Otherwise burns may result.
- Never drop or insert foreign objects or a screwdriver into the ventilation openings or the machine inside. Touching any high-voltage area may result in an electric shock.
- Never damage, alter, heat, or put a strain on the power cable as well as other cables. Doing so may result in a fire or an electric shock.
- If the controller is exposed to water or a chemical agent or if its entry is found inside the controller, turn off the power switch immediately. Continuing to use the machine under such a condition may result in a fire or an electric shock.
- If an error occurs in machine operation, or if abnormal noises or smells are noticed, immediately turn off the power switch. Then contact your nearest Brother dealer or a qualified technician.
- If the machine develops a problem, contact your nearest Brother dealer or a qualified technician.

#### Cleaning

- Turn off the power switch before starting any cleaning work, otherwise the machine may operate if the start switch is pressed by mistake, which could result in injury.
- Be sure to wear protective goggles and gloves when handling the lubricating oil or grease, so that no oil or grease gets into your eyes or onto your skin, otherwise inflammation can result. Furthermore, do not drink the oil or grease under any circumstances, as they can cause vomiting and diarrhoea. Keep the oil out of the reach of children.
### Maintenance and inspection

<table>
<thead>
<tr>
<th>Condition</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>No</strong></td>
<td>Maintenance and inspection of the sewing machine should only be carried out by a qualified technician.</td>
</tr>
<tr>
<td><strong>Caution</strong></td>
<td>Ask your Brother dealer or a qualified electrician to carry out any maintenance and inspection of the electrical system.</td>
</tr>
</tbody>
</table>
| **Caution** | Turn off the power switch and disconnect the power cable (do not pull on the cable itself) from the wall outlet before attempting to perform the following operations. Otherwise, the machine is started if the start switch is pressed by mistake. Injury may occur in such a case.  
  - When carrying out inspection, adjustment, or maintenance  
  - When replacing consumable parts such as a rotary hook, a knife, or a fluorescent lamp |
| **Caution** | If the power switch needs to be left on when carrying out some adjustment, be extremely careful to observe all safety precautions. |
| **Caution** | Use only the proper replacement parts as specified by Brother.  
  - When replacing a fluorescent lamp, use the same-type lamp having a rating of 40 watts.  
  - Wait until the fluorescent lamp cools off before replacement. Failure to do so can result in burns. |
| **Caution** | If any safety devices have been removed, be absolutely sure to re-install them to their original positions and check that they operate correctly before using the machine. |
| **Caution** | Any problems in machine operation which result from unauthorized modifications to the machine will not be covered by the warranty. |

If the power switch needs to be left on when carrying out some adjustment, be extremely careful to observe all safety precautions.
3 Warning labels

* The following warning labels appear on the sewing machine. Please follow the instructions on the labels at all times when using the machine. If the labels have been removed or are difficult to read, please contact your nearest Brother dealer.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Moving parts may cause injury. Operate with safety devices. Turn off main switch before changing needle, cleaning etc.</td>
</tr>
<tr>
<td>2</td>
<td>Hazardous voltage will cause injury. Turn off main switch and unplug power cord before opening this cover.</td>
</tr>
<tr>
<td>3</td>
<td>Never touch or push the thread take up during operation as it may result in injuries to the machine.</td>
</tr>
<tr>
<td>4</td>
<td>Never touch or push the needle bar during operation as it may result in injuries or damage to the sewing machine.</td>
</tr>
<tr>
<td>5</td>
<td>Be sure to connect the ground. If the ground connection is not secure, you run a high risk of receiving a serious electric shock, and problems with correct operation may also occur.</td>
</tr>
<tr>
<td>6</td>
<td>Direction of operation</td>
</tr>
</tbody>
</table>

Safety devices: Finger guard, Belt cover, etc.
Before Starting Operation

Do not force open the shutter for direct contact with the magnetic area.

Do not bring disks near magnetic matters such as magnetic screwdriver or the back side of the programmer.

Do not store floppy disks in an extremely high or low ambient temperature.

Do not use floppy disks under high humidity.

Do not use or store floppy disks in a dusty place.

Do not store floppy disks under direct sunlight.

Do not bend the disk. Do not put things on the disk.

Avoid contact with solvent or drink.

Store it in the case immediately after using it to protect it from dust and damage.

Use a commercially available cleaning disk to clean the head of the floppy disk drive periodically.

Do not remove the disk out of the drive during the access lamp is lit.
Protecting data in floppy disks

Write-protection is available for a floppy disk to prevent undesired data deletion. A write-protected disk is read-only. It is recommended to provide write-protection for disks which contain important data. To do so, slide the write-protect notch to open the slot as shown below.

Slide the notch in this direction to prevent data loss or overwriting.

Slide the notch in this direction to write data.
Procedure of Reading This Manual

Explanation of models

This manual explains two models:
- BE-0901E-AC-PC
- BE-1201B-AC-PC

Explanation for individual model is provided by identifying the model name. Check the model before using the machine. The display is BE-0901E-AC-PC.

Configuration of this manual

This manual consists of the following chapters:

Chapter 1   An Introduction of Embroidery Machine
  Provides information on the specifications of the embroidery machine, software installation environment, and basic software operations.

Chapter 2   Preparation of Embroidery Machine
  Describes machine installation and preparation to be conducted before starting embroidering operation.

Chapter 3   Embroidering Procedures
  Provides explanations on the operation panel and briefly reviews the flow of embroidering processes.

Chapter 4   Selecting and Transferring Embroidery Data
  Explains how to use the Embroidery Data Explorer.

Chapter 5   Editing Embroidery Data
  Explains how to use the Embroidery Data Editor.

Chapter 6   Embroidering
  Explains how to use the Machine Controller.

Chapter 7   Operation of Machine
  Provides information on machine operation during embroidering.

Chapter 8   Creating Production Report
  Explains how to use the production report program.

Chapter 9   Maintenance
  Describes appropriate maintenance of the machine.

Chapter 10  Adjustment
  Explains how to adjust the needles.

Chapter 11  List of Error Codes
  Provides information on error codes and action to be taken.

Chapter 12  Troubleshooting
  Provides troubleshooting for the machine.

Chapter 13  Connection and Installation of Optional Equipment
  Describes connections between the machine/computer and optional equipment available.
Contents

SAFETY INSTRUCTIONS.............................................................................................................................................1
Before Starting Operation............................................................................................................................................7
Procedure of Reading This Manual..........................................................................................................................9

Chapter 1  An Introduction of Embroidery Machine
  1. Specifications ..........................................................................................................................................................1-2
  2. Software ...............................................................................................................................................................1-4
    2-1 Necessary Systems .............................................................................................................................................1-4
    2-2 Configuration of Software .................................................................................................................................1-5
    2-3 Notes on use ......................................................................................................................................................1-6
    2-4 Help .................................................................................................................................................................1-6
    2-5 Basic Operation of Software ..............................................................................................................................1-7

Chapter 2  Preparation of Embroidery Machine
  1. Names of Machine Components ............................................................................................................................2-2
  2. Installation ...........................................................................................................................................................2-3
    2-1 Transportation of Machine .................................................................................................................................2-3
    2-2 Installation of Machine .......................................................................................................................................2-3
    2-3 Installation of Operation Panel ..........................................................................................................................2-4
    2-4 Mounting of Guard Bar ....................................................................................................................................2-4
    2-5 Mounting of Cotton Stand .................................................................................................................................2-5
    2-6 Lubrication to Needle Bar Case ..........................................................................................................................2-6
    2-7 Connection of Personal Computer to Machines (for connecting 4 sets) .......................................................2-7
    2-8 Connection of Power Supply ............................................................................................................................2-9
    2-9 Installation of Software .....................................................................................................................................2-11
  3. Preparation for Embroidering ...............................................................................................................................2-12
    3-1 Upper Threading ...............................................................................................................................................2-12
    3-2 Replacement of Bobbin ...................................................................................................................................2-14
    3-3 Replacing and Selecting Needle ........................................................................................................................2-15
    3-4 Preparation of Machine for Operation ............................................................................................................2-16
    3-5 Attachment of Embroidery Hoop and Frame .................................................................................................2-19
    3-6 Adjustment of Thread tension ..........................................................................................................................2-23

Chapter 3  Embroidering Procedures
  Functions of Operation Panel ..................................................................................................................................3-2
    Operation Panel .......................................................................................................................................................3-2
  Flowchart of Preparation for Embroidering .............................................................................................................3-4
    Run the Software ....................................................................................................................................................3-5
    Turn on the Machine Power ..................................................................................................................................3-5
    Register the Machine Name ..................................................................................................................................3-6
    Retrieve the Embroidery Data ...............................................................................................................................3-6
    Start Embroidering ...............................................................................................................................................3-7
Chapter 4  Selecting and Transferring Embroidery Data

Functions (Command Reference)............................................................................................................. 4-2
Description of Screen...................................................................................................................................... 4-3
Creating a Directory...................................................................................................................................... 4-4
Transferring data........................................................................................................................................... 4-5
Copy ................................................................................................................................................................ 4-7
Select from Menu........................................................................................................................................... 4-7
Drag Data....................................................................................................................................................... 4-7
Moving Data.................................................................................................................................................... 4-8
Select from Menu........................................................................................................................................... 4-8
Drag Data....................................................................................................................................................... 4-8
Deleting Data.................................................................................................................................................. 4-9
Recreate an icon............................................................................................................................................... 4-10
Select All ....................................................................................................................................................... 4-11
Renaming Data............................................................................................................................................... 4-12
Finding Data.................................................................................................................................................. 4-13
Adjusting Screen Display.............................................................................................................................. 4-15
Reading Data in Floppy Disk.......................................................................................................................... 4-16
Reading DOS Format Data ............................................................................................................................ 4-16
Converting the Non DOS format data........................................................................................................... 4-18
Reading Data in Paper Tape............................................................................................................................ 4-22
Settings for Data Reading............................................................................................................................... 4-24
Writing Data in DST Format........................................................................................................................... 4-25
Viewing Pattern Information......................................................................................................................... 4-26

Chapter 5  Editing Embroidery Data

Functions (Command Reference).................................................................................................................... 5-2
Description of Screen...................................................................................................................................... 5-4
Opening Embroidery Data............................................................................................................................... 5-5
Setting Display............................................................................................................................................... 5-6
Centering ........................................................................................................................................................ 5-6
Zoom .............................................................................................................................................................. 5-6
Needle Penetration........................................................................................................................................ 5-8
Embroidering Start/End ................................................................................................................................ 5-8
Trim and pause ............................................................................................................................................. 5-8
Microstitch .................................................................................................................................................... 5-9
Needle Bar and Speed Range ........................................................................................................................ 5-9
Thread Color ............................................................................................................................................... 5-13
Tool bar .......................................................................................................................................................... 5-14
Status Bar .................................................................................................................................................... 5-14
Back to Previous Status ................................................................................................................................. 5-15
Undo .............................................................................................................................................................. 5-15
Redo .............................................................................................................................................................. 5-15
Editing............................................................................................................................................................ 5-16
Rotate ............................................................................................................................................................ 5-16
Horizontal Flip .............................................................................................................................................. 5-17
Vertical Flip .................................................................................................................................................. 5-17
Point Symmetry ........................................................................................................................................... 5-17
Repeat ........................................................................................................................................................... 5-17
Resize ............................................................................................................................................................ 5-20
Delete Stitch ............................................................................................................................................... 5-20
Insert or Delete Code .................................................................................................................................. 5-21
Insert Lock Stitch ....................................................................................................................................... 5-22
Chapter 6  Embroidering

Functions (Command Reference) .......................................................... 6-2
  When the Power to the Machine is Off .................................................. 6-2
  When the Power to the Machine is On .................................................... 6-2
Description of Screen ........................................................................... 6-5
Settings before Turning On the Machine .............................................. 6-6
  Displaying the Tool Bar ........................................................................ 6-6
  Displaying the Status Bar ...................................................................... 6-7
  Upgrading the Version of Interface Board ............................................ 6-7
  Reset Interface Board ........................................................................... 6-7
  Communication Port ............................................................................. 6-7
  Language .............................................................................................. 6-8
Settings after Turning Power On .......................................................... 6-9
  Tool Bar ............................................................................................... 6-9
  Status Bar ......................................................................................... 6-9
  Zoom In ............................................................................................. 6-9
  Zoom Out .......................................................................................... 6-9
  Zoom In Specified Range ..................................................................... 6-9
  Fit to Window ..................................................................................... 6-10
  Whole Pattern ................................................................................... 6-10
  Grid ..................................................................................................... 6-11
  Hoop ................................................................................................. 6-11
  Hoop position fine adjustment ............................................................ 6-11
  Needle Penetration ............................................................................ 6-12
  Thread Color ..................................................................................... 6-13
  Needle Bar and Speed Range ............................................................... 6-13
  Setting Needle Bar ............................................................................. 6-13
  Setting Ranges .................................................................................. 6-17
  Grid Setting ....................................................................................... 6-18
  Background color ............................................................................. 6-18
  Renaming Machine ............................................................................ 6-19
  Viewing Machine Information .............................................................. 6-20
  Design Information ............................................................................ 6-20
  Setting Window Display ..................................................................... 6-20
  Minimizing and Aligning Windows ..................................................... 6-21
  Language ........................................................................................... 6-21
  Copying Data to Other Machines ....................................................... 6-23
  Configuration .................................................................................... 6-24
  Upgrading the Machine Program ....................................................... 6-24
Setting the Machine ....................................................................................................................................................6-25
Needle Bar ...............................................................................................................................................................6-25
Same Speed Range ..................................................................................................................................................6-26
Pause ........................................................................................................................................................................6-26
Speed Range ............................................................................................................................................................6-27
Hoop Feed Position ................................................................................................................................................6-28
Embroidery Area .....................................................................................................................................................6-29
Embroidery Hoop ....................................................................................................................................................6-29
Thread Trimming ....................................................................................................................................................6-31
Boring ......................................................................................................................................................................6-32
Thread Breakage Sensor .........................................................................................................................................6-33
Automatic Step Back ..........................................................................................................................................6-34
Automatic Hoop Feed ........................................................................................................................................6-34
End of embroidery ................................................................................................................................................6-35
Mending ..................................................................................................................................................................6-36
Adjust ......................................................................................................................................................................6-37
Driving shaft ............................................................................................................................................................6-38
Activate escape with pause .....................................................................................................................................6-38
Short stitch speed reduction ..................................................................................................................................6-39
Thin / Thick Material ..........................................................................................................................................6-40
Area Trace ...............................................................................................................................................................6-41
Default Settings ....................................................................................................................................................6-42
Show Setting ..........................................................................................................................................................6-43
Load Setting ..........................................................................................................................................................6-45
Save Setting ...........................................................................................................................................................6-46
Load Hoop ...............................................................................................................................................................6-47
Embroidering ..........................................................................................................................................................6-52
Starting Embroidering .........................................................................................................................................6-52
Moving the Home Position ..................................................................................................................................6-54
Step-forward/Step-back .......................................................................................................................................6-55
Entering in the Step-forward/Step-back Mode .......................................................................................................6-55
Setting Step-forward/Back Distance or Timing ......................................................................................................6-56
Stepping Forward/Back .........................................................................................................................................6-57
Resuming Embroidering ....................................................................................................................................6-58
Moving Embroidery Position .................................................................................................................................6-59
Centering Pattern ................................................................................................................................................6-60
Saving Data .............................................................................................................................................................6-61
Save ........................................................................................................................................................................6-61
Save As .................................................................................................................................................................6-61
Running Other Programs ....................................................................................................................................6-62
Chapter 7  Operation of Machine

1. Operating Procedures .................................................................................................................. 7-2
   1-1 Power Source .......................................................................................................................... 7-2
   1-2 Preparation for Embroidering .............................................................................................. 7-2

2. Machine Stop .............................................................................................................................. 7-3
   2-1 Stopping the Machine with the stop switch unit ................................................................. 7-3
   2-2 Emergency Stop of the Machine with the shut-off switch unit ........................................ 7-3

3. Permission for Hoop Movement ............................................................................................... 7-4

4. Jog Switches ............................................................................................................................. 7-5
   4-1 Hoop Movement to Start Position ..................................................................................... 7-5

5. Area Check .................................................................................................................................. 7-6
   5-1 External Tracing .................................................................................................................. 7-6
   5-2 Automatic Hoop Movement in Area ................................................................................... 7-6

6. Hoop Feed Position .................................................................................................................... 7-7

7. Measures against Thread Breakage .......................................................................................... 7-8
   7-1 Remedies ............................................................................................................................ 7-8

8. Inching Mode ............................................................................................................................ 7-9
   8-1 Inching Mode during Embroidering (Forcible Hoop Movement) ..................................... 7-9

Chapter 8  Creating Production Report

Functions (Command Reference) .................................................................................................. 8-2

Description of Screen .................................................................................................................. 8-3

Displaying Report ......................................................................................................................... 8-4
   Display Example of Details ..................................................................................................... 8-5
   Display Example of Thread Breakage Information on Needle Bar ......................................... 8-6
   Display Example of Thread breakage Information in Pattern ............................................... 8-7
   Display Example of Output Information ................................................................................ 8-8
   Display Example of Total Output Information ...................................................................... 8-10

Setting Display Items .................................................................................................................. 8-12
   General ....................................................................................................................................... 8-12
   Details ....................................................................................................................................... 8-13
   Thread Breakage Information on Needle Bar ........................................................................... 8-14
   Thread Breakage Information in Pattern .................................................................................. 8-14
   Output Information .................................................................................................................... 8-15
   Total Output Information ......................................................................................................... 8-16
   Recess Time Setting .................................................................................................................. 8-17

Save As CSV .................................................................................................................................. 8-18

Printing Production Report ....................................................................................................... 8-19
   Page Setup ............................................................................................................................... 8-19
   Print .......................................................................................................................................... 8-19

Copying Report Data .................................................................................................................. 8-20
# Contents

## Chapter 9  Maintenance

1. Cleaning ................................................................................................................................. 9-2  
   1-1 Cleaning and Lubrication of Rotary Hook ..................................................................... 9-2  
   1-2 Cleaning of Needle Plate .............................................................................................. 9-3  
2. Oiling .................................................................................................................................... 9-4  
   2-1 Head ............................................................................................................................... 9-4  

## Chapter 10  Adjustment

1. Adjusting Needle Bar Height ............................................................................................... 10-2  
2. Adjustment of Timing Between Needle and Rotary Hook ............................................ 10-6  
3. Adjustment of Presser Foot Height .................................................................................... 10-7  
4. Adjustment of Thread Trimmer ......................................................................................... 10-8  
5. Thread Wiper Adjustment .................................................................................................. 10-9  
6. Adjusting the Belt Tension ................................................................................................. 10-10  

## Chapter 11  Error code list

## Chapter 12  Troubleshooting

Mechanical Section .................................................................................................................. 12-2  
Electrical Section .................................................................................................................... 12-4  

## Chapter 13  Connection and Installation of Optional Equipment

1. Attaching Bobbin Winder .................................................................................................... 13-2
Chapter 1
An Introduction of Embroidery Machine
# 1. Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>9 needle embroidery machine head</th>
<th>12 needle embroidery machine head</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Embroidery machine used</strong></td>
<td>9 needle embroidery machine head</td>
<td>12 needle embroidery machine head</td>
</tr>
<tr>
<td><strong>Application</strong></td>
<td>Pattern embroidery</td>
<td></td>
</tr>
<tr>
<td><strong>Sewing speed</strong></td>
<td>Maximum 1200 rpm</td>
<td></td>
</tr>
<tr>
<td><strong>Sewing area</strong></td>
<td>Max. 300 (V) x 450 (H) mm (flat hoop area) *</td>
<td>300 (V) x 450 (H) mm (tubuler square hoop area)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>85 (V) x 360 (H) mm (with cap frame)</td>
</tr>
<tr>
<td><strong>Feed system</strong></td>
<td>By pulse motor wire drive</td>
<td></td>
</tr>
<tr>
<td><strong>Stitch length</strong></td>
<td>0.1 ~ 12.7 mm (minimum pitch: 0.1 mm)</td>
<td></td>
</tr>
<tr>
<td><strong>Storage medium</strong></td>
<td>3.5 2DD floppy disk (Tajima format)</td>
<td>3.5 2HD floppy disk (the equivalent to Tajima format)</td>
</tr>
<tr>
<td></td>
<td>3.5 2DD floppy disk (Barudan FDR/FMC format) (embroidery data in FDR35III/V format only)</td>
<td>3.5 2DD floppy disk (ZSK format)</td>
</tr>
<tr>
<td></td>
<td>3.5 floppy disk (brother ECS format)</td>
<td></td>
</tr>
<tr>
<td><strong>Thread trimming</strong></td>
<td>Automatic thread trimmer</td>
<td></td>
</tr>
<tr>
<td><strong>Needle thread breakage</strong></td>
<td>Needle thread breakage detector</td>
<td></td>
</tr>
<tr>
<td><strong>Power supply</strong></td>
<td>Single phase 120 V, 200 V, 220 V, 240 V, 500 VA</td>
<td></td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>195 kg</td>
<td></td>
</tr>
<tr>
<td><strong>Dimensions</strong></td>
<td>1050 (W) x 1016 (L) x 1484 (H) mm</td>
<td></td>
</tr>
<tr>
<td><strong>Options</strong></td>
<td>Embroidery hoops in different sizes, Bobbin winder, Parts for boring</td>
<td></td>
</tr>
</tbody>
</table>

* ...... The field size is restricted by the types of hoop used.
Chapter 1 An Introduction of Embroidery Machine

2. Software

2-1 Necessary Systems

The following systems are needed for installing the software.

• Personal computer with a CPU of Intel Pentium 166 MHz or above
  (Even if the software is operable under the environment less than the required specification, such a case is out of the scope of warranty.)

• Memory of 32 MB or above (Even if the software is operable under the environment less than the required specification, such a case is out of the scope of warranty.)

• Free space of 100 MB or above in the hard disk

• 3.5 floppy disk drive

• CD-ROM drive

• Video card of 1024 × 768 resolution in 256 colors
  (1280 × 1024 in 65000 colors is recommended.)

• Serial port (RS-232C) × 1

• PCI slot x 1
  Use the full-size type. Any low-profile type PCI or half-pitch type PCI cannot be used.
  In the PCI slot, an interface board (option) shown in the photo below is installed.

<table>
<thead>
<tr>
<th>Full-size type PCI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Board dimension</td>
</tr>
<tr>
<td>Bracket dimension</td>
</tr>
</tbody>
</table>

• Windows 95/98/2000/NT4.0/XP (Some functions are not available with Windows NT. Refer to page 4-18.)

• Non-DOS data such as Barudan FDR is not supported to do input and output of data in case of FDD using USB.
2-2 Configuration of Software

This software is mainly composed of the following four programs. The software is provided on CD-R.

(1) Embroidery Machine Controller
(2) Embroidery Data Explorer
(3) Embroidery Data Editor
(4) Production Report

Program Functions

(1) Machine Controller
This program controls embroidering operation of the machine.
A embroidering status can be displayed on the screen in real time, and data for operating the machine can be set.

(2) Embroidery Data Explorer
This program handles files of embroidery data on patterns.
Transmission of embroidery data to the machine, as well as copy, move and retrieval of a file are available by means of this program. Embroidery data can be converted from the paper tape or floppy disk.

(3) Embroidery Data Editor
This program allows editing of data on embroidering operation including scaling, rotation, color change, etc.

(4) Production Report
This program is for collecting data on actual embroidering operation and calculating output, etc.
Chapter 1 An Introduction of Embroidery Machine

Relationship among Programs
When the software is started, the program (1) for actuating the machine starts first.

Next, embroidery data is called by the program (2). Use the program (3), when required, for editing and embroidering. The embroidery data is totaled by the program (4).

The programs (2), (3), and (4) can be started from the menu of the program (1). Each program can also be started independently.

2-3 Notes on use
• Do not start other application software while the machine controller is used.
• Do not set the screen saver.
   To cancel setting, select the "Screen saver" on the "Control panel" screen and set "Not used".
• Set the computer not to use the system agent included in the Windows 95 PLUS.

2-4 Help
The software is equipped with an on-line help function as an accessory.
Click , then the icon of the desired item. A message is displayed to explain the meaning and usage of the item. Pressing the [F1] key brings up the help screen of the application for your reference.
2-5 Basic Operation of Software

This section explains the basics of using the software. It covers only the operating procedures that are commonly used for the software. If there are any special operating procedures inherent to a program, they are explained in each section.

How to Use the Mouse

When selecting an icon or a menu displayed on the screen, move the white arrow pointer on the screen to the required position, then press the button on the mouse.

Place the mouse on a flat, smooth surface and move it by sliding on it. The white arrow pointer moves along the mouse motion.

The mouse has two buttons. The left one is used in general. There are three ways of operating the mouse button as described below:

**Click**

Press the left button of the mouse once. "Click [xx]" means moving the white arrow pointer to "xx" and pressing the left button once.
Double-click
Press the left mouse button twice continuously. Do not leave a long pause in between. "Double-click \([xx]\)" means moving the white arrow pointer to "xx" and pressing the left button twice continuously.

Drag
Move the mouse while holding down the left button. Dragging is used for defining an area.
Names of Screen Components

Names of major components on the screen of the machine controller are described below:

- **Menu**
  Processing of software is carried out by giving relative commands. Commands are divided in groups and stored in each menu. The menu displayed on the screen changes depending on the program which is currently active.

- **Tool bar**
  A command is executed by clicking a relative icon (illustrated button) on the screen. If it is hard to recognize icons from illustrations, move the white arrow pointer to the icon. The name of the icon is displayed.

- **Scroll bar, scroll box, and scroll arrow**
  Some patterns may not be displayed entirely on the screen. Use the scroll bar to see hidden parts of the pattern into view.
  When displaying the right part, for example, click the scroll arrow at the right end. The box in the scroll bar moves to the right. By dragging the scroll box to the right, the screen can scroll quickly.
  The vertical scroll bar can be used in the same way.

- **Status bar**
  This bar is for displaying a brief description of the selected command.
Selection of Menu
Processing of software is carried out by giving a command. A command can be given by the mouse as described below:

1. Move the arrow pointer to a menu name and click there.

2. A list of commands is displayed. Click the required command.

Dimmed commands cannot be used unless an appropriate item is selected. Depending on the model, some items cannot be used.

Commands with a mark have sub menus.

The check mark (√) indicates that the command is selected.

When the arrow pointer is moved to another menu while a list of commands is displayed, those of the latter menu are displayed.
Chapter 2
Preparation of Embroidery Machine
1. Names of Machine Components

■ BE-0901E-AC-PC

- Thread guide bar
- Pulley (A)
- Thread tension dial
- Thread take-up
- Inner thread guide
- Embroidery hoop
- Table
- Power switch
- Control box
- 9-bar cotton stand
- Operation panel
- Carriage
- Guard bar

■ BE-1201B-AC-PC

- Pulley (A)
- Thread guide bar
- Thread guide A, B
- 12-bar cotton stand
- Operation panel
- Carriage
- Guard bar
- Table
- Power switch
- Control box
2. Installation

**DANGER**

- Embroidery machines should be installed only by trained engineers.
- Electric wiring should be laid by your distributor or electric experts.
- The sewing machine weighs more than 195 kg. The installation should be carried out by two or more people.
- Do not connect the power source until installation is completed. Doing so may start the machine unintentionally through an accidental activation of the START switch, resulting in bodily injuries.
- Install a machine in a place away from a high-frequency welding machine or other machines that may generate a strong electric noise. Failure to do so may cause the embroidery machine to malfunction.
- Be sure to connect the ground. If the ground connection is not secure, you run a high risk of receiving a serious electric shock, and problems with correct operation may also occur.
- Secure the machine with the nuts when installing it so that it will not move by placing the leveling seat on the sound floor.

* After installation is completed, get the power supply from a dedicated outlet.
* When connecting multiple machines, exercise care not to exceed the capacity of the outlet.

2-1 Transportation of Machine

When relocating the machine, lift it by the steel frame.

Note) Never lift the machine by the table or the guard bar.

2-2 Installation of Machine


2. If the table is not stable, loosen nuts [2] and turn leveling seats [1] for adjustment.

When relocating the machine, raise leveling seats [1]. The machine can then be moved with casters [3].
2-3 Installation of Operation Panel

Loosen thumb bolt [1]. Adjust the operation panel position for ease of use, and tighten thumb bolt [1].

2-4 Mounting of Guard Bar

Attach guard bar [1] to the machine. Fix it with bolts and washers from the lower side of the frame.
2-5 Mounting of Cotton Stand

**BE-0901E-AC-PC**

1. Attach two thread guide support bars [2] to the cotton stand assembly [1], while fitting into the two holes.


3. For safety reason, attach vinyl tubes to the end of the thread guide assembly [3].

**BE-1201B-AC-PC**

1. Attach two thread guide support bars [2] to the cotton stand assembly [1], while fitting into the two holes.


3. For safety reason, attach vinyl tubes to the end of the thread guide assembly [3].
2-6 Lubrication to Needle Bar Case

**CAUTION**

Turn off the power switch before starting any cleaning work, otherwise the machine may operate if the start switch is pressed by mistake, which could result in injury.

Proper lubrication is necessary for keeping the machine head in good condition.

Before operating the machine for the first time after unpacking or after leaving the machine without operation for a long period of time, supply one or two drops of oil to two sections at the top and the bottom of each needle bar. (See the left figure.)

Note): Use the Brother's specified embroidery machine oil (Nisseki Embroidery Lube No. 10 or the equivalent).

- Supplying an excessive amount of oil will cause dripping onto the material.
2-7 Connection of Personal Computer to Machines (for connecting 4 sets)

Be sure to ground the personal computer.

1. Turn off the power of the personal computer and the machine.
2. Open the cover of the personal computer and insert an interface board included with the Machine Controller (option) into the slot for the PCI bus.
3. Connect the interface board male connector and the personal computer RS-232C connector (COM1 or RS-232C-1) using the attached short RS cable included with the Machine Controller (option).

**CAUTION**

Before inserting or removing IF cables or RS cables, turn off the power switches of the machine, the computer, and peripheral equipment.
4. Connect the control box connector SBUS2 of the first machine and the control box connector SBUS1 of the second machine using an IF cable.

5. Attach the side cover of the control box.

6. Connect the control box connector SBUS2 of the second machine and the control box connector SBUS1 of the third machine using an IF cable.

7. Connect the control box connector SBUS2 of the third machine and the control box connector SBUS1 of the forth machine using an IF cable.

8. Attach a terminator included with the Machine Controller (option) to the control box connector SBUS2 of the forth (last) machine.
   - The IF cables used for connection are identical. There is no difference between the two ends of the IF cable.
   - The order of connecting four machines is arbitrary.
   - The maximum number of connecting machines is four.
   - A terminator should be connected to the connector SBUS2 of the lastly connected machine. Connection to SBUS1, 2 can be interchangeable.
2-8 Connection of Power Supply

Connection of Power Supply of Embroidery Machine

⚠️ DANGER

Be sure to connect an earth cable. Failure to do so may result in electric shock.

Use a cord plug that matches the receptacle type.

When using a conversion plug, be sure to connect the grounding cable (green/yellow stripe) to the grounding terminal of the outlet.
Uninterruptive power supply

This unit is for protecting a personal computer from commercial power interruption, voltage drop, and external noise. Use of an uninterruptive power supply is strongly recommended.

- This unit is not an attachment of the Brother's embroidery machine, and should be purchased separately from a different source.
- When using an uninterruptive power supply, be sure to establish grounding.
2-9 Installation of Software

Use an attached CD-R for installing software. If a personal computer with no CD-R drive unit is used, connect a drive unit to the computer.

1. Set the CD-R for installation.
   Setting the CD-R starts the installation program automatically.

2. Select the language and click "Next".

3. The screen for user registration is displayed. Input your name and department. Click [OK] after inputting is finished.

4. Check the user information. Click [OK] if the contents are correct.

5. Specify a folder for setup.

6. Click [TO NEXT] to start installation.

7. After setup is properly finished, a message is displayed.

8. Click [OK] to complete installation.
3. Preparation for Embroidering

CAUTION

Turn off the power switch before starting preparation. Failure to do so may start the machine unintentionally through an accidental activation of the START switch, resulting in bodily injuries.

3-1 Upper Threading

BE-0901E-AC-PC

1. Pass an upper thread from the cotton stand through the holes of the thread guide right above each cotton stand bar. When passing the thread, pass it through the first hole from the lower side, lead it around the thread guide, and then pass it through the second hole also from the lower side.

2. Push up the thread guide tension disc with your finger, and pass it from the left to the lower hole. Wind the thread clockwise twice around thread breakage pulley [2].

3. Pass the thread through the hole of upper thread guide (upper) [3]. Wind the thread clockwise once around the rotary tension disc and place it on the spring.

4. Pass the thread through each hole of upper thread guide (middle) [4] and thread guide (upper) [5].

5. After passing the thread through the hole of thread guide (upper) [5], insert the thread into the right side of the inner thread guide and pass it through the hole of the thread take-up.

6. Bring the thread back to the inner thread guide. Insert the thread into the hole from the upper section into thread guide A [6] and lower thread guide [7].

7. Pass the thread through the hole of the needle bar thread guide [8] and pass it through the needle eye. Do not pass it through the presser foot. Pass it to needle bar thread guide at the front of lower thread guide [7].
1. Pass an upper thread from the cotton stand through the holes of the thread guide right above each cotton stand bar. When passing the thread, pass it through the first hole from the lower side, lead it around the thread guide, and then pass it through the second hole also from the lower side.

2. Push up the thread guide tension disc with your finger, and pass it from the left to the lower hole. Wind the thread clockwise twice around thread breakage pulley [2].

3. Pass the thread through the hole of upper thread guide (upper) [3]. Wind the thread clockwise once around the rotary tension disc and place it on the spring.

4. Pass the thread through each hole of upper thread guide (middle) [4] and thread guide (upper) [5].

5. After passing the thread through the hole of thread guide (upper) [5], insert the thread into the front side of the inner thread guide and pass it through the hole of the thread take-up.

6. Bring the thread back to the inner thread guide. Insert the thread into the hole from the upper section into thread guide A and lower thread guide [7].

7. Pass the thread through the hole of the needle bar thread guide [8] and pass it through the needle eye. Do not pass it through the presser foot. Pass it to needle bar thread guide at the front of lower thread guide [7].
3-2 Replacement of Bobbin

Note) Remove dust, lint and oil from the bobbin case before replacement.

■ Removing bobbin case

1. Open the rotary hook cover [1].
2. Hold the knob [2] and take out the bobbin case.
3. Close the knob and take out the bobbin [3].

■ Replacing bobbin

1. Put a new bobbin in the bobbin case.
   Check the winding direction. (refer the figure)
   If the bobbin is inserted in the reverse direction, the lower thread may slip too much,
   resulting in a problem in embroidering.
   Check that the bobbin is pushed out of the bobbin case by about 0.5 mm. If not, the slip
   prevention spring of the bobbin case does not work. Adjust the height of the spring or
   replace it with a new one.

   2. Slide the thread under the tension spring [5] through the notch [4].

   3. Pull out the thread from the hole of the tension spring [5].

   4. Pull out the thread by about 50 mm.
### Attaching bobbin case

1. Hold the knob [2] and attach the bobbin case securely.

2. Close the rotary hook cover [1].

---

### 3-3 Replacing and Selecting Needle

#### Removing needle

Loosen the set screw [1] and remove the needle [2].

#### Attaching needle

With the flat side facing the front, insert the needle all the way until it meets the end of the needle bar. Tighten the set screw [1] firmly.

- Set the needle so that the notched part will come on the rotary hook side.
- The needle eye should not be angled to the left (when viewed from the front).

#### Selecting needle

- When using special threads such as gold, silver, and rame yarn, use a heavy-duty needle (#11~#16). For better finish, paste the waxed paper on the back of the material.
- In general, use DB x K5 #11 ~ #18 according to the material thickness. For knitted materials, use DB x K23 #11 because its rounded point prevents the knit thread from breaking.

---

<table>
<thead>
<tr>
<th>Material</th>
<th>Needle</th>
<th>Needle thickness</th>
</tr>
</thead>
<tbody>
<tr>
<td>Denim</td>
<td>DB × K5</td>
<td>#14, #16, #18</td>
</tr>
<tr>
<td>Leather</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Handkerchief</td>
<td></td>
<td>#9, #10</td>
</tr>
<tr>
<td>Shirt</td>
<td></td>
<td>#11, #12, #13</td>
</tr>
<tr>
<td>Towel</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
3-4 Preparation of Machine for Operation

■ Check the following before turning on the power

<table>
<thead>
<tr>
<th>Thread</th>
<th>(1) Are upper thread settings complete? (2) Are threads passed smoothly? (3) Are threads passed through needles? (4) Are lower thread settings complete?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Embroidery hoop</td>
<td>(1) Is there any looseness in the material? (2) Is the hoop clamped securely?</td>
</tr>
<tr>
<td>Needle stop position</td>
<td>(1) Are thread take-ups aligned horizontally? (2) Are needle bars positioned at the top?</td>
</tr>
</tbody>
</table>

![Diagram showing thread take-up 1](This figure shows model BE-0901E/AC.)

Note) If thread take-up [1], which is not in the drive position, is out of alignment, raise it by hand. The stopper works to align thread take-up [1] with the others.

Turning on the power switch brings up the message "Moving frame" and sounds a beep as a warning. Then, the X and Y carriages move the embroidery hoop to the home position or the position where it was located at the end of the previous operation. Check that there is no obstacle above the hoop which will interfere with needles or presser feet.
When the machine is turned on:
"E-07" may appear on the operation panel while a buzzer sounds intermittently. In such a case, the machine is not ready to start because the needle bar case is not positioned correctly, and thus the needles are not in proper alignment with the holes of the needle plates. Follow the steps below to fix this.

1. Check if the needles stop in the normal position.
   When cam plate [2] is raised, it is in the automatic jump position. This is the normal position.

   If knob [3] cannot be turned or is too heavy to rotate, thread take-up [1] or the needle bar is not in the normal position. Check if any obstacle interferes with the needle end or the presser foot.
   Note) Do not turn the knob forcibly.

3. There is a dead zone in which the needle bar case cannot be moved even by turning knob [3]. Turn the knob to the normal position in the vicinity of the center of the dead zone.

4. Press STOP .

5. A buzzer sounds and the X and Y carriages move automatically so as to bring the hoop center to the home position or to the position where it was located at the end of the previous operation.
If the machine is not ready to operate because the needle bars in the drive position are out of the normal position, "E-05" appears. Follow the steps below if this occurs.

1. Set "100° (→)" on the pulley to "STOP POSITION."

2. Press 🛠️. Check if the needle bars are lowered. If so, return them to the normal stop position. (Refer to "Normal needle stop position" on page 2-18.)

3. A buzzer sounds, the X and Y carriages move automatically so as to bring the hoop center to the home position or to the position where it was located at the end of the previous operation.

Viewing the inside through the clearance, each needle bar is in the jump position at the top (as shown in the figure) and needle bar vertical piece [5] lowers to keep it from contact with needle bar clamp [6]. (The thread take-ups are aligned horizontally.)

Note) When the power switch has been turned on or when restarting embroidering while the machine is stopped or suspended, be sure to return the needles to the normal stop position.

- Align all thread take-ups horizontally.
- If the needle bar in the embroidering position is lowered with needle bar vertical piece [5], separate them in the following manner. For safety, insert a tool such as a screwdriver into the clearance at the front left side of the needle bar case and turn the needle bar vertical piece [5] by pushing its end. When the needle bar and the needle bar vertical piece are separated, the needle bar is raised to the top by the spring.
3-5 Attachment of Embroidery Hoop and Frame

Attaching a square frame and a flat hoop frame (standard)

1. Attach flat hoop frame (assembly) [1] to X carriage [2], and tighten two screws [3]. Fit the projections of the X carriage into the inner holes.

2. Loosen two screws [4]. Attach square frame [5].

3. As shown in Figure A, fit the left metal part of the square frame to the screw. As shown in Figure B, fit the right metal part to the screw. Tighten two screws [4] securely.

4. If the material over the square frame is not set properly, stitches may be skipped, threads may be broken, or the material may shrink during embroidering. Make an adjustment using screw [6].
### Attaching a tubular round frame (optional)

Note) When using a tubular round frame with the frame for it, remove table from the machine.

   Fit the projections of the X carriage into the inner holes.

2. As Figures B and C show, while pushing up plate springs [5], insert the right and left metal parts of tubular round frame [4] and fit projections [6] into the hole of the tubular round frame.

3. If the material over the tubular round frame is not set properly, stitches may be skipped, threads may be broken, or the material may shrink during embroidering. Make an adjustment using screw [7].

4. Remove screw [9] in Figure A. Position frame arms [8] R and L for the tubular round frame according to the mounting pitch of the tubular round frame, and attach the arms.
   Note) Attach the frame arms R and L symmetrically.
### Attaching a sash frame set (optional)

1. Turn off the machine power switch.
   - **Note:** Save the two screws, spring washers, and plane washers removed in the above step. They will be used later.
   - **Note:** When attaching the sash frame, check that the side with felt affixed to the back faces the front.

With a sash frame, the allowable embroidery area is 300 mm (vertical) x 450 mm (horizontal).
### Adjustments of Thread Tension

#### Adjustment of upper thread

Adjust upper thread tension to 0.7~1.3N when the thread is pulled at the needle bar thread guide.

#### Correct adjustment

Turn the upper thread tension dial so that the needle thread can be pulled to the back of the material and that the lower stitch width will be about 1/3 of the upper stitch width.

#### Adjustment of tension spring

1. The tension spring should be adjusted to 6~8 mm in height and 0.07~0.12 N in force.
2. For adjusting the height, loosen the screw [1] and turn the tension spring bracket [2].

3. For adjusting the tension spring force, insert a driver tip in the groove of the thread tension bar [3] and turn it.

**Lower thread tension**

The standard tension of the lower thread is 0.15~0.3N. This tension may vary depending on the used thread. In general, press the bobbin case to a smooth vertical surface and hang the designated number of coins. Turn the thread tension screw so that the lower thread will come out smoothly.

*Note* Check that the bobbin is pushed out of the bobbin case by about 0.5 mm. If not, the slip prevention spring of the bobbin case does not work. Adjust the spring in height or replace it with a new one. (Refer to “Replacing Bobbin” on page 2-14)
Chapter 3
Embroidering Procedures

After installation of machine and setting-up of the personal computer (PC), start embroidering. This chapter explains about the operation panel on the machine as well as precautions for the actual embroidering process.
Functions of Operation Panel

Operation Panel

Starts embroidering.

Restarts after moving the carriage to embroidering start position by using the jog switch.

Restarts embroidering after a suspension.

Cancels errors during embroidering.

Exits from the embroidering mode. Hold down this switch and press \( \text{POWER} \) switch.

Suspends embroidering.

Trims thread during suspension.
### Chapter 3 Embroidering Procedures

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Switch" /></td>
<td>Checks the embroidering area.</td>
</tr>
<tr>
<td><img src="image" alt="Switch" /></td>
<td>Exits from embroidering mode. Press this switch while holding down switch simultaneously to stop embroidering.</td>
</tr>
<tr>
<td><img src="image" alt="Switch" /></td>
<td>Moves the hoop automatically into the embroidering area when the embroidery position is out of the area. When this switch is pressed while the computer has given a command to move embroidery hoop (&quot;HOOP&quot; appears on the panel), the embroidery hoop moves designated position.</td>
</tr>
<tr>
<td><img src="image" alt="Switch" /></td>
<td>Moves the hoop to software-set position. When this switch is pressed again, the hoop returns to the previous position.</td>
</tr>
<tr>
<td><img src="image" alt="Switch" /></td>
<td>Clear inching when this switch is pressed in the inching mode.</td>
</tr>
<tr>
<td><img src="image" alt="Switch" /></td>
<td>Moves the needle bar. The needle moves by the diameter every time this switch is pressed.</td>
</tr>
<tr>
<td><img src="image" alt="Switch" /></td>
<td>Moves the hoop. Step-back or forward is available during suspension. (Use switches only.) Changes the speed range during embroidering (Use switches only). Sets machine to the inching mode when is pressed while holding down during suspension. Carries out inching of the hoop when the switch is pressed in the inching mode. (appears on the panel)</td>
</tr>
<tr>
<td><img src="image" alt="Switch" /></td>
<td>Selects the flat or cap hoop. This selection should be done before turning the power ON to the machine. The setting will not be changed if the selection is done after turning the power OFF.</td>
</tr>
</tbody>
</table>

#### Canceling errors

When an error message appears, it is canceled by pressing switch. Pressing other switches can stop alarm sound. When thread breakage or wiper out error has occurred, step-back or forward switch can be used to cancel errors.
Flowchart of Preparation for Embroidering

Run PC.

Run software (→ page 3-5).

Turn on the machine power. (→ page 3-5)

Register the machine name for initial start-up. (→ page 3-6)

Retrieve the embroidery data by using explorer (→ page 3-6).

“Chapter 4 Selecting and Transferring Embroidery Data” (→ page 4-1)

Edit the retrieved embroidery data.
“Chapter 5 Editing Embroidery Data” (→ page 5-1)

Click of the machine controller.

Press on the operation panel.

Press on the operation panel.
Run the Software


Turn on the Machine Power

1. Change the Flat / Cap hoop select switch according to the hoop to be used.
2. Turn on the power switch.
3. The computer screen changes when the machine is turn on.
Register the Machine Name

Enter the machine name if the software is run for the first time or when a new machine is connected.

1. Enter a machine name.

   ![Selecting a color for the machine](W1370Q)

   Select an identifying color for the machine. This color is shown on the title bar for a while when the arrow pointer is moved to the title bar of a machine window.

2. Click [OK].

Retrieve the Embroidery Data

1. Click  

   The embroidery data explorer starts up.

2. Double-click the desired data or click [OK] after clicking the desired data.

3. The selected data is transferred to the machine controller.

4. Click  

   The data is transferred to the machine for preparation of embroidering.
   
   When the embroidery hoop is displayed, the area check is conducted not with the embroidery area but with the frame shape. However, the area check of spider net frame and cap frame is conducted with the embroidery area.
   
   Be sure to note that at the time of the area check with the frame shape, the warning message won't be displayed when all of the embroidery data is placed apart from the embroiderable area (in green) in the frame or covers up the whole embroiderable area (in green) of the frame.
Start Embroidering

1. Check that the READY lamp on the machine operation panel is on.
   ![POWER](image1)
   ![READY](image2)

2. Press to check the embroidering area.

3. Press to start embroidering.
Chapter 4
Selecting and Transferring Embroidery Data

Clicking on the machine controller brings up a screen which allows selecting or transference of registered embroidery data. Moving, copying, and deleting of embroidery data can also be carried out on this screen.
## Functions (Command Reference)

### File menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Creates a new directory. ([→ page 4-4])</td>
</tr>
<tr>
<td>Exit of Selection</td>
<td>Transfers embroidery data to the machine controller. ([→ page 4-5])</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits from embroidery data explorer.</td>
</tr>
</tbody>
</table>

### Edit menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies the selected embroidery data. ([→ page 4-7])</td>
</tr>
<tr>
<td>Move</td>
<td>Moves the selected embroidery data to a different directory. ([→ page 4-8])</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected embroidery data. ([→ page 4-9])</td>
</tr>
<tr>
<td>Rename</td>
<td>Renames the selected embroidery data. ([→ page 4-12])</td>
</tr>
<tr>
<td>Recreate an icon</td>
<td>Creates an icon of data for other models. ([→ page 4-10])</td>
</tr>
<tr>
<td>Select all</td>
<td>Selects all the data. ([→ page 4-11])</td>
</tr>
</tbody>
</table>

### View menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tool Bar</td>
<td>Displays the tool bar.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Displays the status bar.</td>
</tr>
<tr>
<td>List</td>
<td>Displays embroidery data in the text form. ([→ page 4-15])</td>
</tr>
<tr>
<td>Image</td>
<td>Displays the image of embroidery data. ([→ page 4-15])</td>
</tr>
<tr>
<td>Sort by Name</td>
<td>Sorts embroidery data by name (in the reverse order). ([→ page 4-15])</td>
</tr>
<tr>
<td>Sort by Stitches</td>
<td>Sorts embroidery data by the number of stitches in ascending order (in descending order). ([→ page 4-15])</td>
</tr>
<tr>
<td>Sort by Colors</td>
<td>Sorts embroidery data by the number of colors in ascending order (in descending order). ([→ page 4-15])</td>
</tr>
<tr>
<td>Sort by Date</td>
<td>Sorts embroidery data by date in descending order (in ascending order). ([→ page 4-15])</td>
</tr>
<tr>
<td>Refresh</td>
<td>Displays the latest data by updating the screen. ([→ page 4-15])</td>
</tr>
</tbody>
</table>

### Tool menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find Files</td>
<td>Retrieves files. ([→ page 4-13])</td>
</tr>
<tr>
<td>DST/DSB/DSZ → ECS Conversion</td>
<td>Reads DOS format data. ([→ page 4-16])</td>
</tr>
<tr>
<td>Non DOS (Barudan, ZSK...) Conversion</td>
<td>Reads non-DOS format data. ([→ page 4-18])</td>
</tr>
<tr>
<td>Tape → ECS Conversion</td>
<td>Reads data in paper tape. ([→ page 4-22])</td>
</tr>
<tr>
<td>ECS → DST Conversion</td>
<td>Converts ECS data to DST data. ([→ page 4-25])</td>
</tr>
<tr>
<td>Setup</td>
<td>Defines settings of data reading. ([→ page 4-24])</td>
</tr>
</tbody>
</table>
Description of Screen

To display hierarchy of directories in PC

To display name and outline of the data registered in the selected directory
Creating a Directory

Creates a new directory. A directory can be created within another directory.

1. Click and select a parent directory in the window on the left.


3. Enter a new folder name.

4. Click [OK].

5. A new directory is added to the window.
Transferring data

Transfer registered embroidery data to the machine controller or Embroidery data editor.

1. Double-click data, or click data and OK.
The explorer exits automatically after transferring the selected data.

Transferring DST and DSB data

1. Double click DST or DSB data or click the data and click OK.

2. The pattern image is displayed. To read the data, click [OK].
3. Set the number of feeds for trim. Select the number of feeds or specify the feed length for trimming and click [OK].

The data is transferred and the explorer ends automatically.

<table>
<thead>
<tr>
<th>No. of times feed is performed before thread trimming</th>
</tr>
</thead>
<tbody>
<tr>
<td>How many times is feed required to be performed before thread trimming?</td>
</tr>
<tr>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Feed length for trimming</th>
</tr>
</thead>
<tbody>
<tr>
<td>mm</td>
</tr>
</tbody>
</table>

Transferring data on a network

1. Before starting the software, click [START] - [PROGRAM] - [EXPLORER].
2. Select [Map Network Drive] from Tool menu.
3. Select the desired drive and enter the path, and click [OK].
4. Exit from the explorer.

If no image appears:

If no image of embroidery data appears, select "Display Detail" on "Screen" of the control panel to adjust display color. Choose one of the following options, then restart PC.

- 256 colors
- High color (16 bits)
- Full-color (24 bits)

Select the display color using "Color Pallet".
Copy

Copies embroidery data.

■ Select from the menu or drag the data icon to the destination.

Select from Menu

1. Click data for selection.

2. Select [Copy] from Edit menu or click 

   ![Copy button]

3. Select destination directory. Name copy data.

   ![Save dialog]

4. Click [Save].

Drag Data

1. Click data for selection.

2. Drag data to destination directory while pressing [Ctrl] key.

   The pointer turns into . Release the mouse button when the directory name is inverted.

3. Check that the copy destination directory is correct, then click [Yes].

   ![Save as dialog]
Moving Data

Moves embroidery data to a different directory.

Select from the menu or drag the data icon to the destination.

Select from Menu

1. Click data for selection.

2. Select [Move] from Edit menu or click [ ]

3. Select the destination directory and click [Save].

Drag Data

1. Click data for selection.

2. Drag data to the destination directory.

   The arrow pointer turns into [ ] Release the mouse button when the directory name is inverted.

3. Check that the copy destination directory is correct, then click [Yes].
Deleting Data

Deletes embroidery data.

1. Click data for selection.
   The frame of selected data becomes red.

2. Select [Delete] from Edit menu or click 

   ![Image of Edit menu highlighting Delete]

3. Click [Yes] to delete the selected data.
Recreate an icon

Creates an icon of data for other models.

- Icons of the data created by the following models can be recreated.
  - BE-1204B-BC
  - BE-1204C-BC
  - BE-1206B-BC
  - BE-0901E-AC
  - BE-1201B-AC

1. Click and select the data displayed as "Icon is not completed". The frame of the data selected is displayed in red.

2. Select [Icon is made again.] from the Edit menu.

3. The pattern image is displayed.

4. Click [OK].
**Select All**

Selects all the data in the folder displayed.

- Only copying, movement, and deletion by drag & drop are enabled when multiple patterns are selected simultaneously. Transfer to the machine controller is disabled.

1. Select [Select all] from the Edit menu.
   The frame of the data selected is displayed in red.

   ![In the text display mode](image)

   ![In the image display mode](image)
Renaming Data

Renames the registered embroidery data.

- Data name consists of the name area and three characters called "extension" which indicates data type. Enter ".ECS" at the end of the data name.

![Image of data name with extension]

- Upper and lower cases are not distinguished in the data name.

1. Click data for selection.
   The frame of selected data turns red.

2. Select [Rename] from Edit menu or click 

3. Enter a new data name.
   Enter a data name including extension.

   ![Image of rename dialog box]

4. Click [OK].
Finding Data

Retrieves and views embroidery data.

1. Select [Find Files] from Tool menu.

2. Enter the file name of embroidery data for search.
   Enter the file name correctly.

3. Click [Find].
If the specified embroidery data is found, the data is displayed.

Finding Files With Wildcard Characters

Wildcard characters can be used as a substitute of a single character or multiple characters. Characters "?" and "*" can be used as wildcard characters for search.

- **Using "?"**
  The wildcard character "?" represents any single character. For instance, if "Basket?.ecs" is entered to the file name box, the search will find any file name including 'Basket' and a following character. Any number of wild characters can be used to replace other characters.

- **Using "*"**
  The wildcard character "*" represents a character or combination of characters. For instance, if "*.ecs" is entered to the file name box, the search will find all files with extension "ecs".
Adjusting Screen Display

Selects the information type to display on the screen.

- **Tool bar**
  If it is checked, the tool bar appears.

- **Status bar**
  If it is checked, the status bar appears.

- **File display format**
  Choose either option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List</td>
<td>Displays a list of all embroidery data names and details in the directory in text format.</td>
</tr>
<tr>
<td>Image</td>
<td>Displays a list of all embroidery data names and images in the directory.</td>
</tr>
</tbody>
</table>

- **File sorting order**
  Choose one of the following options. Clicking the icon will switch between ascending order and descending order.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort by Name</td>
<td>Sorts files by name.</td>
</tr>
<tr>
<td>Sort by Stitches</td>
<td>Sorts files by the number of stitches in ascending order (in descending order).</td>
</tr>
<tr>
<td>Sort by Colors</td>
<td>Sorts files by the number of colors in ascending order (in descending order).</td>
</tr>
<tr>
<td>Sort by Date</td>
<td>Sorts embroidery data by date in descending order (in ascending order).</td>
</tr>
</tbody>
</table>

- **Updating to the latest information**
  Displays the latest information.

1. Select [Refresh] from View menu.
Reading Data in Floppy Disk

Reads data in a floppy disk and registers it as embroidery data.

- The following data formats can be registered.

  - **DOS format data**
    - Tajima: Data with file name "xxxx.DST"
    - Barudan: Data with file name "xxxx.DSB"
    - Zanks: Data with file name "xxxx.DSZ"

  - **Non DOS format data**
    - Barudan FDR
    - Barudan FMC
    - Zanks ZSK

Reading DOS Format Data

1. Select [DST/DSB/DSZ → ECS Conversion] from Tool menu.

2. Select data to read and click [Open].

3. The image of the selected pattern appears.
4. Set feed counts for thread breakage. Select the number of feeds or specify the feed length for trimming and click [OK].

5. Select the directory to save and name the file. Do not change extension ".ECS".

6. Click [Save].
Chapter 4  Selecting and Transferring Embroidery Data

Converting the Non DOS format data
This function is not available with Windows NT.

Viewing Files
To view files of FDR, FMC and ZSK data, carry out the following steps:

- Viewing Details

  Click 📁.

  Names, types, Numbers, sizes, number of stitches of FDR data are displayed.
  Names, sizes, number of stitches of FMC data are displayed.
  Names, Numbers, sizes, number of stitches of ZSK data are displayed.

When reading FDR data

When reading FMC data

When reading ZSK data
Chapter 4  Selecting and Transferring Embroidery Data

■ Viewing Icon

Click  

![Image of File List window with FDR icons]

■ Preview and Refresh

The data image can be displayed before reading the data. Click the desired icon or the name for display. Click  to display the data image. On the detailed display, "fdr" and "fmc" changes to image display. To cancel the preview, click  

![Image of File List window with displayed icons]

1. Set the floppy disk such as Barudan which is non-DOS format at the floppy disk drive of the PC.

2. Select [Non DOS (Barudan, ZSK...) Conversion] from Tool menu.
3. Select data to read and click [OK].

When "Details" is selected

When "Icon" is selected

4. The image of the selected pattern appears. To convert the selected data into ECS data. Click [OK].
5. Set feed counts for thread breakage. Select the number of feeds or specify the feed length for trimming and click [OK].

6. Select the directory to save the file and name the file. Do not change extension ".ECS".

7. Click [Save].
Reading Data in Paper Tape

Saves data in paper tape as embroidery data.

- Paper taper reader is required for reading data.
- Before saving any data, check that the paper tape reader is connected to PC correctly.
- Available interfaces are as follows:
  - COM1
  - COM2
- Readable data formats of paper tape are as follows:
  - Tajima
  - Barudan
  - Zanks (ZSK)

1. Turn on the power to the paper tape reader.

2. Set paper tape after the LED of READ button light up.

3. Select [Tape → ECS Conversion] from Tool menu.

4. Select data format and click [OK].

The paper tape reader starts reading data.
5. The image of the selected pattern appears.

6. Select the directory to save and name the file. 
   Do not change extension ".ECS".

7. Click [Save].
Settings for Data Reading

Sets up the interface and data transfer speed of the paper tape reader or external disk drive.

1. Select [Setup] from Tool menu.

2. Select port and speed.

3. Click [OK].
Writing Data in DST Format

Convert the ECS data into DST data for saving.

1. Click the desired ECS data to convert into DST data.

2. Select [ECS to DST conversion] from Tool menu.

3. Select the directory to save and name the file.
   Do not change extension ".dst".

4. Click [Save].

5. Set feed counts for thread breakage. Select the count and click [OK].
# Viewing Pattern Information

Detail information of embroidery data can be checked.

- The following items can be checked.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pattern name</td>
<td>File name and path of embroidery data</td>
</tr>
<tr>
<td>File Version</td>
<td>Version number of the file</td>
</tr>
<tr>
<td>No. of stitches</td>
<td>The number of stitches in embroidery data</td>
</tr>
<tr>
<td>No. of colors</td>
<td>The number of colors used in embroidery data</td>
</tr>
<tr>
<td>Mask Size</td>
<td>Size of masking</td>
</tr>
<tr>
<td>Start of Embroidering</td>
<td>Coordinates of embroidering start position</td>
</tr>
<tr>
<td>End of Embroidering</td>
<td>Coordinates of embroidering end position</td>
</tr>
<tr>
<td>Last modified</td>
<td>Date of last revision of data</td>
</tr>
</tbody>
</table>

1. Click data for selection.
   The frame of the selected data turns red.

2. Select [Design Information] from Help menu or click 📜.

3. After checking, click [OK].
Chapter 5
Editing Embroidery Data

Clicking 📥 of the machine controller brings up a screen which allows editing of embroidery data. This screen allows simple processing of embroidery data and display setting of display.
## Functions (Command Reference)

### File menu

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Selects embroidery data. (<a href="#">→ page 5-5</a>)</td>
<td></td>
</tr>
<tr>
<td>Merge</td>
<td>Add other pattern to the pattern in editing. (<a href="#">→ page 5-28</a>)</td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>Saves the edited embroidery data over the current file. (<a href="#">→ page 5-30</a>)</td>
<td></td>
</tr>
<tr>
<td>Save as</td>
<td>Saves the edited embroidery data as a separate file. (<a href="#">→ page 5-31</a>)</td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td>Prints embroidery data. (<a href="#">→ page 5-33</a>)</td>
<td></td>
</tr>
<tr>
<td>Print Preview</td>
<td>Views printing condition of embroidery data.</td>
<td></td>
</tr>
<tr>
<td>Print Setup</td>
<td>Designates printer settings.</td>
<td></td>
</tr>
<tr>
<td>Exit Editing</td>
<td>Exits from editing of embroidery data.</td>
<td></td>
</tr>
</tbody>
</table>

### Edit menu

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Returns to the previous step. (<a href="#">→ page 5-15</a>)</td>
<td></td>
</tr>
<tr>
<td>Redo</td>
<td>Repeats the step of &quot;Undo&quot;. (<a href="#">→ page 5-15</a>)</td>
<td></td>
</tr>
<tr>
<td>Rotate</td>
<td>Rotates the image. (<a href="#">→ page 5-16</a>)</td>
<td></td>
</tr>
<tr>
<td>Horizontal Flip</td>
<td>Flips the image horizontally. (<a href="#">→ page 5-17</a>)</td>
<td></td>
</tr>
<tr>
<td>Vertical Flip</td>
<td>Flips the image vertically. (<a href="#">→ page 5-17</a>)</td>
<td></td>
</tr>
<tr>
<td>Point Symmetry</td>
<td>Rotates the image 180 degrees about the center. (<a href="#">→ page 5-17</a>)</td>
<td></td>
</tr>
<tr>
<td>Repeat</td>
<td>Repeats copying of the image. (<a href="#">→ page 5-17</a>)</td>
<td></td>
</tr>
<tr>
<td>Resize</td>
<td>Resizes the image. (<a href="#">→ page 5-20</a>)</td>
<td></td>
</tr>
<tr>
<td>Delete Stitch</td>
<td>Delete a stitch whose length is the designated length or less. (<a href="#">→ page 5-20</a>)</td>
<td></td>
</tr>
<tr>
<td>Insert or delete code</td>
<td>Insert or delete the code for trim, pause and color change. (<a href="#">→ page 5-21</a>)</td>
<td></td>
</tr>
<tr>
<td>Insert lock stitch</td>
<td>Insert a lock stitch before and after thread trimming. (<a href="#">→ page 5-22</a>)</td>
<td></td>
</tr>
</tbody>
</table>

### Change menu

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Changes the start position of embroidery data. (<a href="#">→ page 5-23</a>)</td>
<td></td>
</tr>
<tr>
<td>End</td>
<td>Changes the end position of embroidery data. (<a href="#">→ page 5-24</a>)</td>
<td></td>
</tr>
<tr>
<td>Mask</td>
<td>Changes the mask of embroidery data. (<a href="#">→ page 5-25</a>)</td>
<td></td>
</tr>
<tr>
<td>Group</td>
<td>Group the patterns created in &quot;Repeat&quot; into one. (<a href="#">→ page 5-26</a>)</td>
<td></td>
</tr>
</tbody>
</table>

### View menu

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Centering</td>
<td>Centers embroidery data. (<a href="#">→ page 5-6</a>)</td>
<td></td>
</tr>
<tr>
<td>Zoom</td>
<td>Zooms in or out. (<a href="#">→ page 5-6</a>)</td>
<td></td>
</tr>
<tr>
<td>Needle Penetration</td>
<td>Displays the needle penetration positions. (<a href="#">→ page 5-8</a>)</td>
<td></td>
</tr>
<tr>
<td>Embroidering Start/End</td>
<td>Displays the start/end positions of embroidering. (<a href="#">→ page 5-8</a>)</td>
<td></td>
</tr>
<tr>
<td>Trim and pause</td>
<td>Displays the code insertion position for trim and pause. (<a href="#">→ page 5-8</a>)</td>
<td></td>
</tr>
<tr>
<td>Microstitch</td>
<td>Displays the position of the stitch whose length is the designated length or less. (→ page 5-9)</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Needle bar and speed range</td>
<td>Displays the setting screen for needle bar and speed range. (→ page 5-9)</td>
<td></td>
</tr>
<tr>
<td>Thread color</td>
<td>Displays the pattern in thread color. (→ page 5-13)</td>
<td></td>
</tr>
<tr>
<td>Tool Bar</td>
<td>Shows/hides the tool bar. (→ page 5-14)</td>
<td></td>
</tr>
<tr>
<td>Status Bar</td>
<td>Shows/hides the status bar. (→ page 5-14)</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 5  Editing Embroidery Data

Description of Screen

The image shows a screenshot of an embroidery design software interface. The screen is divided into several sections:

- **Tool bar**
- **Status bar**
- **Design Information**
- **About This Application**
- **Help**

The tool bar contains various options such as:

- **Open**
- **Save**
- **Fit to Window**
- **Display Range**
- **Needle bar and Speed Range**
- **Horizontal Flip**
- **Vertical Flip**
- **Point Symmetry**
- **Redo**
- **Undo**
- **Rotate**
- **Resize**
- **Print**
- **Thread color**
- **Needle bar and Speed Range**

The design on the screen appears to be the word "brother" in an intricate embroidery pattern.
Opening Embroidery Data

This function is available with embroidery data editor.

1. Select [Open] from File menu or click  

2. Double-click the data or click the data and  

![Embroidery Data Editor](image)
Chapter 5  Editing Embroidery Data

**Setting Display**

Sets the condition of the display screen. Items with check marks to the left are selected.

**Centering**

Brings the image to the center of the screen.

1. Select [Centering] from View menu.

**Zoom**

Zooms in/out the pattern.

- The following four types of zooming are available.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In</td>
<td>Enlarges the image to 125%.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Reduces the image to 80%.</td>
</tr>
<tr>
<td>Range</td>
<td>Magnifies the range defined by the mouse to the full window size.</td>
</tr>
<tr>
<td>Full Window</td>
<td>Displays the whole image to the size of the window.</td>
</tr>
</tbody>
</table>

**Zoom In**

1. Select [Zoom] - [Zoom In] from View menu or click 📷.

Repeats zooming of the image by the number of clicks.
**Zoom Out**

1. Select [Zoom] - [Zoom Out] from View menu or click 开始.

Repeats zooming of the image by the number of clicks.

**Range**

1. Select [Zoom] - [Range] from View menu or click .

2. Drag and define the range to zoom in with the mouse.

**Fit to window**

1. Select [Zoom] - [Fit to window] from View menu or click .
Chapter 5  Editing Embroidery Data

Needle Penetration
Chooses whether or not the needle penetration positions are displayed.

1. Select [Needle Penetration] from View menu.

Embroidering Start/End
Displays start and end points as "S" and "E" on the screen respectively. If points "S" and "E" are identical, "E" has priority over "S".

1. Select [Embroidering Start/End] from View menu.

Trim and pause
Displays the position of the trim code and the pause code. Trim is displayed by X and pause is displayed by □.

1. Select [Trim and pause] from the View menu.
Microstitch
Displays the position of the stitch whose length is less than the designated length with [ ].
Length can be designated from 0.0 to 1.0 mm in units of 0.1 mm.

1. Select [Microstitch] from the View menu.

2. Designate the length of the stitch to be viewed. Select [View] and designate the length of the microstitch.

3. Click [OK].

Needle Bar and Speed Range
Displays status of the needle bar and speed range.

1. Select the [Needle bar and speed range] from the View menu or click [ ].
Change of display color

When the color of the embroidering sequence is changed, the color displayed on the screen is changed. When ending embroidering or reading other data, the confirmation screen for saving the setting appears.

A display color can be selected from among the following four items.

| Basic color which can be selected screen on the "Color selection" | Refer to steps 1 and 2. |
| Color sample supplied by a manufacturer | Refer to steps 1 and 3. |
| Color sample created by a user | Refer to steps 1 and 3. |
| Adjustment of an intermediate color from the color sample supplied by a manufacturer or naming and registration of a newly created color | Refer to steps 1 to 7. |

The following screen is displayed when colors to be displayed are set to 256 in [Display Properties] and the color sample supplied by a manufacturer cannot be selected or an intermediate color cannot be created.

1. Double click the desired embroidering sequence to change the color.
2. Select a new color on the [Color selection] screen.

3. When selecting a color from a color sample, click maker name or [User] and double click [Color].

4. When finely adjusting the selected color, click [Medium color]. Click [User] to create a new color, then click [Addition].

The needle bar number can be changed.
5. Select an arbitrary color from basic colors. Click [Define Custom Colors] to create a medium color.

6. Select a color by clicking on the color chart or by inputting a value, and click [OK].

7. Input the name of the color and click [OK] when [User] is selected in step 4.
Changing needle bar allocation

1. Drag the embroidering sequence on the needle bar number.

Setting the range

1. Double click the desired needle bar range to change.
2. Click the desired range.
3. Click [OK].

Thread Color

The embroidery data is displayed in thread color.

- This function is available only when the embroidery data edit is started from the machine controller.

1. Select [Thread color] from the View menu or click
Tool bar
Shows/hides the tool bar. The tool bar contains icons with the same functions as the menu.

1. Select [Tool Bar] from View menu.

Before selecting

![Before selecting tool bar](Image1)

After selecting

![After selecting tool bar](Image2)

Status Bar
Shows/hides the tool status. The status bar provides information on the current status and advice for operation.

1. Select [Status Bar] from View menu.

Before selecting

![Before selecting status bar](Image3)

After selecting

![After selecting status bar](Image4)
Back to Previous Status

**Undo**
Makes the edit or change invalid. The screen returns to the state before the change.

- The screen can return to 3 steps maximum.

1. Select [Undo] from the Edit menu or click 🔄.

**Redo**
Repeats the canceled step of "Undo".

- The screen can return to 3 steps maximum.

1. Select [Redo] from the Edit menu or click 🔄.
Editing

Rotate

- Available range of rotation is -359 to 359 degrees.
- When the patterns to be repeated are grouped, the whole pattern rotates. When they are not grouped, each pattern rotates in each hoop.

1. Select [Rotate] from View menu or click 

2. Select angle.
   - If [Free] is selected, specify the angle.

3. Click [OK].
Horizontal Flip
Flips the image horizontally.

1. Select [Horizontal Flip] from Edit menu or click 

Vertical Flip
Flips the image vertically.

1. Select [Vertical Flip] from Edit menu or click 

Point Symmetry
Flips the image 180 degrees to the center position of the image.

1. Select [Point Symmetry] from Edit menu or click 

Repeat
Repeats copying of the image by the specified number.
The number for repetition is 1 to 100 for both vertical (Row) and horizontal (Column) directions.

- The unit for repetition can be set in inches. To use the inch unit, set the length to [inch] on the [Configuration] of Tool menu of the machine controller. (→ page 6-24)

- The pattern connection can be set in "Direction" as follows:

<table>
<thead>
<tr>
<th>Direction</th>
<th>Pattern Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>From top left, alternating directions</td>
<td>W0716Q</td>
</tr>
<tr>
<td>From top left, left to right direction</td>
<td>W0717Q</td>
</tr>
<tr>
<td>From bottom left, alternating directions</td>
<td>W0718Q</td>
</tr>
<tr>
<td>From bottom left, left to right direction</td>
<td>W0719Q</td>
</tr>
</tbody>
</table>

1. Select [Repeat] from Edit menu or click ![Repeat].

2. Specify the number, interval and direction of repetition.

- **Repeat count in the longitudinal direction**
- **Repeat count in the lateral direction**
- **The value can be directly entered.**
  - Click here to increase/decrease the value.
- **Select the direction of repetition.**
- **Sets margins of the sewing area used for the calculation of the repetition number in the automatic setting.**
- **Select the reference position for spacing.**

   - Longitudinal distance (Unit: 0.1 mm or 0.01")
   - Lateral distance (Unit: 0.1 mm or 0.01")

   - All patterns created in repetition are grouped as a single pattern.
   - The number is set automatically so as the number of repetitions to be the maximum within the sewing area.

3. Click [OK].
Margin setting with [Auto setting] selected
The number is set automatically so as the number of repetitions to be the maximum within the sewing area.

- When [Spacing], [Direction], and [Datum] are pre-selected before [Auto setting] is selected, the setting is performed according to pre-selections.
- [Margin] can be set after [Auto setting] is selected and the margin size you can set is 5 ~ 100mm (0.2 ~ 4.00” in inch) around the sewing area.

Margin setting is performed as follows:

1. Select [Auto setting] and click [Margin].

2. Set the vertical and horizontal margin for sewing area.

3. Click [OK].

4. Click [OK].
Resize
Resizes the image.

- The available range of resizing is 50 to 200% in both the X and Y directions.
- Resizing changes the thread density along with the percentage.

1. Select [Resize] from Edit menu or click .
2. Specify the percentage of resizing.

   ![Click here to increase/decrease the value.]

   The value can be directly entered.

3. Click [OK].

Delete Stitch
Delete a stitch whose length is less than the designated length. Length can be designated from 0.0 to 1.0 mm in units of 0.1 mm.

1. Select [Stitch deletion] from Edit menu.
2. Designate the length of the stitch to be deleted.

3. Click [OK].
4. Deleted result is displayed. Click [OK].
Insert or Delete Code

Codes of trim, pause and color change can be inserted or deleted by moving the needle to the desired position.

1. Select [Insert or delete code] from the Edit menu.

   Needle movement tool bar is displayed.

   1 step
   10 step
   100 step
   Next (previous) color change point
   Next (previous) feed point
   Next (previous) trim code
   Next (previous) pause code

2. Select the movement method of needle position.

   Click either of the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 step</td>
<td>Moves the needle position by 1 step each.</td>
</tr>
<tr>
<td>10 step</td>
<td>Moves the needle position by 10 step each.</td>
</tr>
<tr>
<td>100 step</td>
<td>Moves the needle position by 100 step each.</td>
</tr>
<tr>
<td>Next (previous) color change point</td>
<td>Moves the needle position to the next (previous) color change point.</td>
</tr>
<tr>
<td>Next (previous) feed point</td>
<td>Moves the needle position to the next (previous) feed point.</td>
</tr>
<tr>
<td>Next (previous) trim code</td>
<td>Moves the needle position to the next (previous) trim code.</td>
</tr>
<tr>
<td>Next (previous) pause code</td>
<td>Moves the needle position to the next (previous) pause code.</td>
</tr>
</tbody>
</table>

3. Move the needle position to the desired position.

   Click either of the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consecutive step backward specified</td>
<td>The needle position returns consecutively until the &quot;Stop&quot; button is pressed.</td>
</tr>
<tr>
<td>Step backward specified</td>
<td>The needle position returns for the specified length.</td>
</tr>
<tr>
<td>Stop</td>
<td>The needle position stops movement.</td>
</tr>
<tr>
<td>Step forward specified</td>
<td>The needle position moves forward for the specified length.</td>
</tr>
<tr>
<td>Consecutive step forward specified</td>
<td>The needle position moves forward consecutively until the &quot;Stop&quot; button is pressed.</td>
</tr>
<tr>
<td>Number</td>
<td>Move the needle directly to the indicated position.</td>
</tr>
</tbody>
</table>

4. Insert or delete the code.

   Click either of the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert (delete) trim code</td>
<td>Insert (or delete) the trim code at the current needle position.</td>
</tr>
<tr>
<td>Insert (delete) pause code</td>
<td>Insert (or delete) the pause code at the current needle position.</td>
</tr>
<tr>
<td>Insert (delete) change color code</td>
<td>Insert (or delete) the change color code at the current needle position.</td>
</tr>
</tbody>
</table>

5. To end code insertion or deletion, click \( \text{OK} \). Modified setting is saved.

   To cancel the modification of setting, click \( \text{X} \).
Insert Lock Stitch

Find the pattern of [Stitch] - [Trim] for [Before Trimming] and find the pattern of [Trim] - [Feed] - [Stitch] - [Stitch] for [After Trimming], then insert a lock stitch.

- Insertion method of lock stitch depends on the length of the second stitch as follows:

<table>
<thead>
<tr>
<th>Stitch length</th>
<th>Method of lock stitch</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.2 mm or more</td>
<td>Insert 3 stitches of 0.3 mm stitch.</td>
</tr>
<tr>
<td>From 0.9 mm to less than 1.2 mm</td>
<td>Insert 2 stitches of 0.3 mm stitch.</td>
</tr>
<tr>
<td>From 0.6 mm to less than 0.9 mm</td>
<td>Insert 1 stitch of 0.3 mm stitch.</td>
</tr>
<tr>
<td>Less than 0.6 mm</td>
<td>Do not insert the lock stitch.</td>
</tr>
</tbody>
</table>

- The inserted lock stitch cannot be deleted. However, use [Undo] in the Edit menu to return to the status before inserting the lock stitch just after the lock stitch is inserted.

1. Select [Insert lock stitch] from the Edit menu.

2. Designate the position to insert the lock stitch and click [OK].

3. If the lock stitch can be inserted, click [Yes].
Changing Data

Changing Start

Changes the start position of embroidering.

<table>
<thead>
<tr>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center, upper left corner, middle left corner, lower left corner, middle top edge, middle bottom edge, upper right corner, middle right corner, or lower right corner of the mask</td>
<td>Starts embroidering at the specified position.</td>
</tr>
<tr>
<td>Specify using mouse</td>
<td>Starts embroidering at the position clicked with the mouse.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels the specified position.</td>
</tr>
</tbody>
</table>

1. Select [Start] from Change menu.

![Embroidery Data Editor](image)

Click the start position if [Specify using mouse] is selected.
**Changing End**

Changes the end position of embroidering.

<table>
<thead>
<tr>
<th>Options</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center, upper left corner, middle left corner, lower left corner, middle top edge, middle bottom edge, upper right corner, middle right corner, or lower right corner of mask.</td>
<td>Ends embroidery at the specified position.</td>
</tr>
<tr>
<td>Specify using mouse</td>
<td>Ends embroidery at the position clicked with the mouse.</td>
</tr>
<tr>
<td>End at start position</td>
<td>Ends embroidery at the end position.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels the specified position.</td>
</tr>
</tbody>
</table>

1. Select [End] from Change menu.

Click an end position if [Specify using mouse] is selected.
Mask
Changes the mask that represents the periphery of embroidery data. Since the automatic mask is a rectangle, the pattern within the hoop may be displayed as an error. In this case, set masking in manual mode.

- Mask is displayed in a khaki line.
- There are two types of mask setting as follows:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>The system measures the image size to create a mask automatically.</td>
</tr>
<tr>
<td>Manual</td>
<td>After selecting this mode, specify the mask area using the mouse.</td>
</tr>
</tbody>
</table>

1. Select [Mask] from Change menu. Select automatic or manual mode.
   - If [Automatic] is selected, a mask is created automatically.
   - If [Manual] is selected, drag the area with the mouse to specify the mask.
Group

All patterns created in repetition are grouped as a single pattern.

- The difference between the grouped pattern and the non-grouped pattern is as follows:

  When the patterns are grouped
  - Each pattern is displayed in each mask.
  - The whole grouped pattern rotates. (→ page 5-16)

  ![Grouped patterns](image1)

  When the patterns are not grouped
  - The pattern is displayed only in the original copy source. Figures in other masks represent the embroidery sequence.
  - Each pattern in the mask rotates individually. (→ page 5-16)

  ![Non-grouped patterns](image2)
Setting Group for Repetition

1. Select [Repeat] in the Edit menu or click ![Repeat Icon].

2. Click the checkbox of [Group] to put a check mark.

Selecting from Menu

Merge

Merge other patterns to the pattern in editing.

- If the pattern to be merged is repetition data, it is automatically grouped and merged.
- If the pattern to be merged is grouped repetition data, it is merged at the specified position.

- If the pattern to be merged is non-grouped repetition data, it is merged to each pattern. If the pattern does not fit the mask, the mask is automatically adjusted.

1. Select [Merge] from the File menu.
2. Select the pattern to be merged.
3. The pattern mask is displayed in a broken line. Move the mask to the desired position for merging. Click the mouse.

Move the mouse while pressing the shift key. The mask moves horizontally and vertically.

4. If the position is acceptable, click [Yes].

When [No] is clicked, repeat the steps from 3.

5. The pattern is merged.
Saving Data

Saves the edited data. The edited data can be saved over the current file or renamed as a separate file.

Save

Saves the edited data over the current file. The original data is deleted.

1. Select [Save] from File menu or click ![File Menu]

2. If the edited data is larger than the mask, choose whether to carry out automatic masking or not.

3. If color etc. has been changed, the pattern image appears.
Save As...
Renames and saves the edited data as a new file.

1. Select [Save as...] from File menu.

2. Select the directory to save the new file. Enter a new file name.

3. Click [Save].

4. If the edited data is larger than the mask, choose whether to carry out automatic masking or not.

5. If color etc. has been changed, the pattern image appears.
Viewing Pattern Information

Detail information of embroidery data can be checked.

- The following items can be checked.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. of stitches</td>
<td>The number of stitches in embroidery data</td>
</tr>
<tr>
<td>No. of colors</td>
<td>The number of colors used in embroidery data</td>
</tr>
<tr>
<td>Mask Size</td>
<td>Size of masking</td>
</tr>
<tr>
<td>Start of Embroidering</td>
<td>Coordinates of embroidering start position</td>
</tr>
<tr>
<td>End of Embroidering</td>
<td>Coordinates of embroidering end position</td>
</tr>
</tbody>
</table>

1. Select [Design Information] from Help menu or click 📇.

2. After checking, click [OK].
Printing Data

Prints data in editing.

1. Select [Print] from File menu or click [Print].
   Specify the number of copies and other conditions. Click [OK].
Chapter 6  Embroidering

The PC controls the machine operation as well as settings of the machine. Note that the menu which appears on the screen depends on whether the power to the machine is turned on or off.
Chapter 6  Embroidering

Functions (Command Reference)

**When the Power to the Machine is Off**

<table>
<thead>
<tr>
<th>File menu</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>The machine data is overwritten for saving. (→ page 6-6-1)</td>
</tr>
<tr>
<td>Save As</td>
<td>The machine data is saved as a different name. (→ page 6-6-1)</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits the machine controller.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>View menu</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Tool Bar</td>
<td>Displays the tool bar. (→ page 6-6)</td>
</tr>
<tr>
<td>Status bar</td>
<td>Displays the status bar. (→ page 6-7)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tool menu</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Embroidery Data</td>
<td>Runs the embroidery data editor.</td>
</tr>
<tr>
<td>Embroidery Data Explorer</td>
<td>Runs the embroidery data explorer.</td>
</tr>
<tr>
<td>Production Report</td>
<td>Runs the production report.</td>
</tr>
<tr>
<td>Upgrade Interface Board</td>
<td>(→ page 6-7)</td>
</tr>
<tr>
<td>Reset Interface Board</td>
<td>(→ page 6-7)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Configuration menu</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Port</td>
<td>Sets the communication port between the PC and machine. (→ page 6-7)</td>
</tr>
<tr>
<td>Language</td>
<td>Changes display language. (→ page 6-8)</td>
</tr>
</tbody>
</table>

**When the Power to the Machine is On**

<table>
<thead>
<tr>
<th>Machine menu</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimize Window Size</td>
<td>Minimizes the size of display screen on the machine. (→ page 6-21)</td>
</tr>
<tr>
<td>Rename Machine</td>
<td>Renames the machine. (→ page 6-19)</td>
</tr>
<tr>
<td>Machine Information</td>
<td>Displays machine information. (→ page 6-20)</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits from the machine controller.</td>
</tr>
</tbody>
</table>
### Operation menu

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Embroidering</td>
<td>Starts embroidering. (→ page 6-52)</td>
<td></td>
</tr>
<tr>
<td>Stop Machine</td>
<td>Suspends embroidering. (→ page 6-53)</td>
<td></td>
</tr>
<tr>
<td>Cancel Embroidering</td>
<td>Cancels embroidering. (→ page 6-53)</td>
<td></td>
</tr>
<tr>
<td>Home Position</td>
<td>Moves the home position. (→ page 6-54)</td>
<td></td>
</tr>
<tr>
<td>Step F/B</td>
<td>Carries out step-forward or step-back. (→ page 6-55)</td>
<td></td>
</tr>
<tr>
<td>Move Embroidery Position</td>
<td>Moves embroidering position. (→ page 6-59)</td>
<td></td>
</tr>
<tr>
<td>Centering Pattern</td>
<td>Moves pattern to the center. (→ page 6-60)</td>
<td></td>
</tr>
</tbody>
</table>

### View menu

| Tool Bar                | Displays the tool bar. (→ page 6-9)                                         |       |
| Status Bar              | Displays the status bar. (→ page 6-9)                                       |       |
| Zoom In                 | Zooms in the embroidery data. (→ page 6-9)                                 |       |
| Zoom Out                | Zooms out the embroidery data. (→ page 6-9)                                |       |
| Zoom In Specified Range | Zooms in the specified range. (→ page 6-10)                                |       |
| Fit to Window           | Displays the whole embroidery area. (→ page 6-10)                          |       |
| Whole Pattern           | Displays the whole embroidery data. (→ page 6-10)                         |       |
| Grid                    | Displays 1 x 1 cm square grids on the background. (→ page 6-11)           |       |
| Hoop                    | Displays the outline of embroidery hoop. (→ page 6-11)                    |       |
| Hoop position fine adjustment | Adjusts the view position of the embroidery hoop. (→ page 6-11) |       |
| Needle Penetration      | Displays the position of needle penetration. (→ page 6-12)                |       |
| Thread Color            | Adjusts the color of the embroidery data to the thread spool. (→ page 6-13) |       |
| Needle Bar and Speed Range | Displays needle bar and speed range. (→ page 6-13)              |       |
| Grid Setting            | Sets the color and the pitch of grid. (→ page 6-18)                       |       |
| Background color        | Changes the background color of the data. (→ page 6-18)                   |       |

### Tool menu

| Language                | Changes display language. (→ page 6-8)                                     |       |
| Edit                    | Allows editing of embroidery data.                                        |       |
| Embroidery Data Explorer| Allows selection of embroidery data.                                      |       |
| Production Report       | Creates production report.                                                |       |
| Run Embroidery Data Editor independently | Runs the embroidery data editor. (→ page 6-62)                             |       |
| Run Embroidery Data Explorer independently | Runs the embroidery data explorer. (→ page 6-62)                           |       |
| Copy to Another Machine | Copies embroidery data to other machines. (→ page 6-23)                  |       |
| Configuration           | Sets configuration for embroidering. (→ page 6-24)                        |       |
| Version Upgrades        | Upgrades the version of the machine parts. (→ page 6-24)                 |       |
### Settings menu

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Needle</td>
<td>Uses the same needle bar for all embroidering. (→ page 6-25)</td>
</tr>
<tr>
<td>Same Speed Range</td>
<td>Sets the head. (→ page 6-26)</td>
</tr>
<tr>
<td>Pause</td>
<td>Sets whether to stop the needle bars temporarily when changing all the</td>
</tr>
<tr>
<td></td>
<td>needle bars. (→ page 6-26)</td>
</tr>
<tr>
<td>Speed Range</td>
<td>Defines the speed range. (→ page 6-27)</td>
</tr>
<tr>
<td>Hoop Feed Position</td>
<td>Sets the hoop feed position. (→ page 6-28)</td>
</tr>
<tr>
<td>Embroidery Area</td>
<td>Sets the area for embroidering. (→ page 6-29)</td>
</tr>
<tr>
<td>Embroidery Hoop</td>
<td>Sets the type of embroidery hoop. (→ page 6-29)</td>
</tr>
<tr>
<td>Thread Trimming</td>
<td>Sets the inching and thread removal amount. (→ page 6-31)</td>
</tr>
<tr>
<td>Boring</td>
<td>Uses No. 1 needle bar to perform boring. (→ page 6-32)</td>
</tr>
<tr>
<td>Thread Breakage Sensor</td>
<td>Sets operation of thread breakage sensor. (→ page 6-33)</td>
</tr>
<tr>
<td>Automatic Step Back</td>
<td>Sets automatic step back count for thread breakage. (→ page 6-34)</td>
</tr>
<tr>
<td>Automatic Hoop Feed</td>
<td>Feeds hoop to the hoop feed position automatically after embroidering.</td>
</tr>
<tr>
<td></td>
<td>(→ page 6-34)</td>
</tr>
<tr>
<td>End of embroidery</td>
<td>Sets if the machine returns to the start point after end of embroidery.</td>
</tr>
<tr>
<td></td>
<td>(→ page 6-35)</td>
</tr>
<tr>
<td>Mending</td>
<td>Sets automatic error cancellation upon thread breakage. (→ page 6-36)</td>
</tr>
<tr>
<td>Adjust</td>
<td>Sets the adjusting value. (→ page 6-37)</td>
</tr>
<tr>
<td>Driving shaft</td>
<td>Set the startup speed of the main shaft. (→ page 6-38)</td>
</tr>
<tr>
<td>Activate escape with pause</td>
<td>Sets whether to feed the hoop during temporary stop of the needle bars</td>
</tr>
<tr>
<td></td>
<td>to change colors. (→ page 6-38)</td>
</tr>
<tr>
<td>Short stitch speed reduction</td>
<td>Reduces speed when stitching in a designated small pitch. (→ page 6-39)</td>
</tr>
<tr>
<td>Thin / Thick material</td>
<td>Adjusts the timing of needle drop and hoop movement. (→ page 6-40)</td>
</tr>
<tr>
<td>Area trace</td>
<td>Select the outside shape of area tracing before starting sewing. (→ page 6-41)</td>
</tr>
<tr>
<td>Default Settings</td>
<td>Resets changes of the machine setting to the default at the factory</td>
</tr>
<tr>
<td></td>
<td>shipment. (→ page 6-42)</td>
</tr>
<tr>
<td>Show Setting</td>
<td>Shows the contents of settings. (→ page 6-43)</td>
</tr>
<tr>
<td>Load Setting</td>
<td>Loads the setting details. (→ page 6-45)</td>
</tr>
<tr>
<td>Save Setting</td>
<td>Saves the changed setting. (→ page 6-46)</td>
</tr>
<tr>
<td>Load Hoop</td>
<td>Selects the hoop type. (→ page 6-47)</td>
</tr>
</tbody>
</table>

### Window menu

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascade</td>
<td>Cascades windows. (→ page 6-20)</td>
</tr>
<tr>
<td>Tile</td>
<td>Tiles windows. (→ page 6-20)</td>
</tr>
<tr>
<td>Arrange Icons</td>
<td>Align icons. (→ page 6-22)</td>
</tr>
</tbody>
</table>
Description of Screen

Needle bar and speed range
Thread color
Needle penetration
Whole pattern
Fit to window
Zoom in
Zoom out
Zoom in specified range
Whole pattern
Needle penetration
Thread color
Cancel embroidering
Suspend embroidering
Home position
Step-back/step-forward
Move pattern
Information
About This Application
Help
Tool bar
Open explorer
Open editor
Copy data to other machine
Start embroidering
Suspend embroidering
Status bar
W1060Q
Settings before Turning On the Machine

Describes settings available before the machine is turned on.

- The following items can be set.
  - Displaying the tool bar
  - Displaying the status bar
  - Upgrading the version of interface board (*)
  - Resetting the interface board (*)
  - Communication port
  - Language

(*) Dealer engineers carries out version upgrading and resetting of the interface board.

Displaying the Tool Bar

Shows/hides the tool bar. The tool bar contains icons with the same functions as the menu.

- There are two kinds of tool bars as follows:

<table>
<thead>
<tr>
<th>Tool Bar</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main</td>
<td>Main menu items are displayed on this tool bar.</td>
</tr>
<tr>
<td>Step Back</td>
<td>This tool bar appears during step-back/forward.</td>
</tr>
</tbody>
</table>

1. Select [Tool Bar] from View menu and put the check mark.
   Click here again to remove the check mark. Then the tool bar disappears.
Displaying the Status Bar
Shows/hides the status bar. The status bar provides information on the current status and advice for operation.

1. Select [Status Bar] from View menu and put the check mark.
   Click here again to remove the check mark. Then the status bar disappears.

Upgrading the Version of Interface Board
Upgrades the version of interface board program connected to PC. This function is protected by a password. A dealer engineer will use this function if required.

Reset Interface Board
Resets the CPU on the interface board connected to PC to give the same effect as restart. This function is protected by a password. A dealer engineer will use this function if required.

Communication Port
Sets communication port between PC and machine.

1. Select [Communication Port] from Configuration menu.

2. Select communication port for use.
   If the required port name does not appear, key-in the name.

3. Click [OK].
Language
Changes display language.

- The following three languages are displayed as "Available Languages".

<table>
<thead>
<tr>
<th>Language</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>Displays English.</td>
</tr>
<tr>
<td>Languages system uses</td>
<td>Displays the system language of PC.</td>
</tr>
<tr>
<td>Each respective language</td>
<td>Displays the local language.</td>
</tr>
</tbody>
</table>

1. Select [Language] from Configuration menu (Tool menu when the power to machine is on).
2. Select display language among "Available Languages".

   ![Select Language](W1640.png)

   Select display language among "Available Languages".

When "Each respective language" is selected, the list for "Available Languages" may not be displayed properly.

3. Click [OK].
4. Exit and rerun the software.
Settings after Turning Power On

Describes settings available after turning power on to the machine.

**Tool Bar**
Shows/hides the tool bar. The tool bar contains icons with the same functions as the menu.

Refer to page 6-6.

**Status Bar**
Shows/hides the status bar. The status bar provides information on the current status and advice for operation.

Refer to page 6-7.

**Zoom In**
Enlarges the image to 125%.

1. Select [Zoom In] from Display menu or click 📷.
   Repeats zooming of the image by the number of clicks.

![Before selecting](W1065Q)
![After selecting](W1066Q)

**Zoom Out**
Reduces the image to 80%.

1. Select [Zoom Out] from Display menu or click 📷.
   Repeats zooming of the image by the number of clicks.

![Before selecting](W1065Q)
![After selecting](W1067Q)
Zoom In Specified Range
Enlarges the range specified with the mouse to the full window size.

1. Select [Zoom In Specified Range] from Display menu or click 📷.
The arrow pointer turns into 🔍.

2. Drag and specify the range to zoom in with the mouse.

![Before selecting](image1.png) ![After selecting](image2.png)

Fit to Window
Displays the whole embroidery area.

1. Select [Fit to Window] from View menu or click 🎯.

![Before selecting](image3.png) ![After selecting](image4.png)

Whole Pattern
Displays the whole pattern.

1. Select [Whole Pattern] from View menu or click 🔬.

![Before selecting](image5.png) ![After selecting](image6.png)
Grid
Displays 1 × 1 cm square grids on the background.

1. Select [Grid] from View menu and put the check mark.

![Before selecting](W1071Q)  ![After selecting](W1072Q)

Hoop
Displays the outline of embroidery hoop. The type of embroidery hoop can be changed in [Load Hoop] of Settings menu.

- Embroidering is allowed within the green guide in the hoop.

1. Select [Hoop] from the View menu and put a check mark.
   If the hoop is not displayed, carry out the step to read the hoop. For details, refer to [Load Hoop] (→ page 6-46).

![Before selecting](W1073Q)  ![After selecting](W1074Q)

Hoop position fine adjustment
Adjusts the view position of embroidery hoop.

- The position can be adjusted in the range of ±20 mm in both the X and Y directions.

1. Select [Hoop position] from the View menu.
   The hoop view position is stored in the hoop data. If you reinstall the program, the hoop view position is initialized because it is overwritten.
2. Designate the adjusting position and click [OK].
The hoop is displayed in a displaced position.

**Needle Penetration**
Chooses whether or not the needle penetration positions are displayed. Clicking also provides the same function.

1. Select [Needle Penetration] from View menu and put the check mark.
Thread Color
Displays the pattern using colors currently set to the needle bar. Clicking also provides the same function.

1. Select [Thread Color] from View menu and put the check mark.
Display color of the image changes.

![Before selecting](image1.png) ![After selecting](image2.png)

Needle Bar and Speed Range
Displays the needle bar and speed range.

1. Select [Needle Bar and Speed Range] from View menu and put the check mark or click .

![Setting Needle Bar](image3.png)

Setting Needle Bar
Needle bar allocation and display color can be changed on this screen.

![To display needle bar number and color](image4.png) ![To display embroidering sequence and color](image5.png)
### Changing display colors

- The color of needle bar changes to the actual color.
- Changing the thread spool also changes the display color. A confirmation screen to save appears before exiting from embroidering or retrieving other data.
- A display color can be selected from among the following four items.

<table>
<thead>
<tr>
<th>Color Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic color</td>
<td>Which can be selected on the &quot;Color selection&quot; Refer to steps 1 and 2.</td>
</tr>
<tr>
<td>Color sample</td>
<td>Supplied by a manufacturer Refer to steps 1 and 3.</td>
</tr>
<tr>
<td>Color sample</td>
<td>Created by a user Refer to steps 1 and 3.</td>
</tr>
<tr>
<td>Adjustment</td>
<td>An intermediate color from the color sample supplied by a manufacturer or</td>
</tr>
<tr>
<td></td>
<td>naming and registration of a newly created color Refer to steps 1 to 7.</td>
</tr>
</tbody>
</table>

- The following screen is displayed when colors to be displayed are set to 256 in [Display properties] and the color sample supplied by a manufacturer cannot be selected or an intermediate color cannot be created.

1. Double-click the thread spool or needle bar number.
2. Select a new color on the [Color selection] screen.

![Color selection screen]

The needle bar number can be changed.

3. When selecting a color from a color sample, click maker name or [User] and double click [Color].

![Color selection screen]

4. When finely adjusting the selected color, click [Medium color]. Click [User] to create a new color, then click [Addition].

![Color selection screen]
5. Select an arbitrary color from basic colors. Click [Define Custom Colors] to create a medium color.

![Color toolbar](W1021Q)

6. Click the color chart or enter values to create a new color, and click [OK].

![Color settings](W1022Q)

7. Input the name of the color and click [OK] when [User] is selected in step 4.

![Color input](W1023Q)

Changing needle bar allocation

1. Drag a thread spool to the desired needle bar number.

![Needle bar allocation](W1084Q)
Setting Ranges

There are two methods for setting ranges.

**Changing all ranges**

1. Click [Up] to increase range. Click [Down] to reduce range. One clicking changes the range by one level.

**Changing individual range**

1. Double-click the range display.
2. Click a speed range for selection.

   ![Diagram of speed range](image)

   Click here to put a check mark for pause before starting the designated embroidering sequence.

3. Click [OK].
Grid Setting
Sets the pitch and the color of grid.

- The grid interval can be set at the increment of 1 mm (0.1 inch for inch unit).
- The value for setting is 1 - 100 mm (0.1 - 10 inches for inch unit).

1. Select [Grid setting] from the View menu.

![Grid setting menu](image)

2. Set the pitch.
   Click the [color] to change the grid color. For setting, refer to steps 5 to 7 in page 6-16.

![Pitch setting](image)

Background color
Changes the background color of the data.

1. Select [Background color] from the [View] menu.
2. Select or create the background color. Refer to steps 5 to 7 on page 6-16 for details.

Renaming Machine

Rename the registered machine.

- Up to 50 characters can be registered for a machine name.


2. Enter a new name.

   Select an identifying color for the machine. This color is shown on the title bar for a while when the arrow pointer is moved to the title bar of a machine window.

3. Click [OK].
   If the message "The entered name already exists" appears, enter another name.
Viewing Machine Information
Detail specification of the machine can be displayed.

2. Click [OK] after checking the information.

Design Information
Detail specification of the embroidery data can be checked.

<table>
<thead>
<tr>
<th>Pattern name</th>
<th>File name and path of embroidery data</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. of stitches</td>
<td>The number of stitches in embroidery data</td>
</tr>
<tr>
<td>No. of colors</td>
<td>The number of colors used in embroidery data</td>
</tr>
<tr>
<td>Mask Size</td>
<td>Size of masking</td>
</tr>
<tr>
<td>Start of Embroidering</td>
<td>Coordinates of embroidering start position</td>
</tr>
<tr>
<td>End of Embroidering</td>
<td>Coordinates of embroidering end position</td>
</tr>
</tbody>
</table>

1. Select [Design Information] from Help menu or click ![Design Information]
2. After checking, click [OK].

Setting Window Display
Specifies the window that displays machine condition if multiple machines are connected simultaneously.

- There are two types of window display as follows:

<table>
<thead>
<tr>
<th>Window Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascade</td>
<td>Windows are slightly offset.</td>
</tr>
<tr>
<td>Tile</td>
<td>Windows are tiled.</td>
</tr>
</tbody>
</table>
1. Select [Cascade] or [Tile] from Window menu.

When [Cascade] is selected

When [Tile] is selected

Minimizing and Aligning Windows

Windows on the screen can be minimized to the icon size and aligned.

Minimize Window Size

1. Select [Minimize Window Size] from Machine menu or click on the upper right corner of the screen.

Click here.

2. The window is minimized.
Arrange Icons
Minimized windows that are scattered can be aligned.

- This command is available for minimized windows.

1. Select [Arrange Icons] from Window menu.

2. The minimized windows are aligned.

Changing window size
Several square buttons with figures are displayed at the right end of the title bar. These buttons are used to change the window size.

- If this button is clicked when running an ordinary software, it is displayed on the task bar in the minimized size as a button.

- If this button is clicked, the window size changes to a medium size.

- If this button is clicked, the window changes to the full size of the desktop.

- This button is used to end the software or to close the folder. This button cannot be clicked when the machine window is displayed.
Language
Changes display language.
Refer to page 6-8.

Copying Data to Other Machines
When multiple machines are connected, the embroidery data of a machine can be copied to another machine.

1. Click the window of the machine displaying the copy source data.

2. Click the button.

3. Click and select the machine name of the destination.
Chapter 6  Embroidering

4. Click [OK].

The data is copied.

Configuration

Sets the environment of data reading and display.

1. Select [Configuration] from Tool menu.

2. Click and select the item for setting.

[When reading file, Micro Stitch is eliminated.] is set to be deleted in default status (checked).

3. Click [OK].

Upgrading the Machine Program

Upgrades the programs at each part of the machine.
This function is protected by a password. A dealer engineer will use this function if required.
Setting the Machine

Performs the detail setting of the embroidering status. Items that can be selected in Setting menu are explained here.

**Needle Bar**

Patterns are sewn by one needle.

1. Select the [Needle]-[Same Needle] from Settings menu.
2. Click the needle number for selection.

![Image of Needle Bar Selection](W1108Q)

3. Click [OK].

   The embroidering sequence appears at all specified needle points.

![Image of Embroidering Sequence](W1109Q)

**Default setting (equating the sewing order number and needle bar number)**

Chapter 6   Embroidering

Same Speed Range
Embroiders patterns at the specified speed range.

1. Select [Same Speed Range] from Settings menu.
2. Click a speed range for selection.

3. Click [OK].
The speed range appears at the specified areas.

Pause
Sets whether to stop the needle bars temporarily when changing all the needle bars.

Stopping all the needle bars temporarily

Resetting temporary stop of all the needle bars
1. Select [Pause] - [Delete all] from Settings menu.
**Speed Range**

Specifies the maximum speeds for respective ranges suitable for the hoop type.

- Actual embroidering speed depends on the pitch.
- Before shipment, "1" is set to the highest speed; "6" is set to the lowest speed.

1. Select [Speed Range] from Settings menu.

2. Specify the desired range.

![Speed Range Table]

<table>
<thead>
<tr>
<th>Range</th>
<th>Minimum</th>
<th>Maximum</th>
<th>Speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>250</td>
<td>700</td>
<td>&lt;525-1200</td>
</tr>
<tr>
<td>2</td>
<td>350</td>
<td>900</td>
<td>&lt;650-1300</td>
</tr>
<tr>
<td>3</td>
<td>500</td>
<td>1100</td>
<td>&lt;850-1300</td>
</tr>
<tr>
<td>4</td>
<td>700</td>
<td>1300</td>
<td>&lt;1050-1300</td>
</tr>
<tr>
<td>5</td>
<td>900</td>
<td>1500</td>
<td>&lt;1250-1300</td>
</tr>
<tr>
<td>6</td>
<td>1000</td>
<td>1600</td>
<td>&lt;1450-1300</td>
</tr>
</tbody>
</table>

When a value exceeding the above ranges is entered, it is automatically set to the min. or max. speed.

3. Click [OK].
Hoop Feed Position
Set the basic position of the hoop (hoop feed position) for cancellation of embroidering.

- The hoop feed position can be set only in the embroidering area surrounded by a red frame.
- The hoop feed position can not be set in the upper side of the frame when [Tubular] is selected in [Embroidery hoop] and the frame is displayed on the screen.

1. Select [Hoop Feed Position] from Settings menu.
2. Click the point to feed the hoop.

3. The gray cross appears and shows the hoop feed position.
**Embroidery Area**
Sets the embroidery area.

1. Select [Embroidery Area] from Settings menu.
2. Drag the embroidery area using the mouse for designation.

![Embroidery Area Image]

The embroidery area is displayed in light blue.

**Embroidery Hoop**
The type of specified embroidery hoop changes the display.

- The kind of the selectable frame varies according to settings at machine side.
- The following selections are available:
  - Tubular
  - Flat
  - Border
  - Wide cap
  - Semi-wide cap
  - Baseball cap
1. Select [Embroidery Hoop] and the type from Settings menu.

   ![Embroidery Hoop Selection](image)

   The pattern direction and embroidering area may vary depending on the selected embroidery hoop type. Make sure that the selection is correct.

   The following shows the screen example with the frame selected.

   When “Tubular (ALL)” is selected.

   ![Tubular Example](image)

   The image is displayed upside down. The speed is automatically adjusted to 800 rpm or less.

   When “Wide cap (ALL)” is selected.
The image is displayed upside down.
The speed is automatically adjusted
to 800 rpm or less.

When “Semi-wide cap (ALL)” is selected.

### Thread Trimming

The following items can be set:

<table>
<thead>
<tr>
<th>Enable inching</th>
<th>Sets inching motion for thread trimming.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hoop movement after thread trimming</td>
<td>Sets the needle penetration length for trimming.</td>
</tr>
<tr>
<td>The length can be set in inches. To set the length in inch unit, select [Inch] from the [Configuration] of Tool menu.</td>
<td></td>
</tr>
<tr>
<td>The available values are as follows:</td>
<td></td>
</tr>
<tr>
<td>For mm</td>
<td>0 - 100 mm (The standard value is 15 mm.)</td>
</tr>
<tr>
<td>For inch</td>
<td>0 - 3.9 inch (The standard value is 0.6 inch.)</td>
</tr>
<tr>
<td>Thread length (1-10) for all machines</td>
<td>Sets the overall thread amount through the needle.</td>
</tr>
<tr>
<td>Value of 1 to 10 can be set. The smaller the value is, the shorter the length is.</td>
<td></td>
</tr>
<tr>
<td>Thread length after thread trimming</td>
<td>Sets the overall thread amount through the needle.</td>
</tr>
<tr>
<td>Value of 1 to 10 can be set. The smaller the value is, the shorter the length is.</td>
<td></td>
</tr>
</tbody>
</table>

1. Select [Thread Trimming] from Settings menu.
2. Set inching, thread length, etc.
3. Click [OK].
Boring

The following items can be set.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boring</td>
<td>Sets whether or not boring is performed by attaching a boring knife to the needle bar.</td>
</tr>
<tr>
<td>Shift data</td>
<td>Shifts the hoop by 12 mm while the needle bar with a boring knife attached is selected.</td>
</tr>
<tr>
<td>Shift needles</td>
<td>Sets the range of needle bar to be shifted. Normally, a boring knife is attached to No. 1 needle bar. Set 1 - 1.</td>
</tr>
</tbody>
</table>

- The Boring setting can be performed only for embroidering data that has been created for boring. The machine cannot check whether embroidering data is for boring or not. When performing embroidering, be sure to check the data.
- Before performing embroidering, attach the following optional parts to the machine.
  - Boring knife
  - Boring needle plate, Finger guard
- If editing such as reduction/enlargement and rotation is applied to embroidering data that has been created for boring, embroidering may not be performed correctly.

1. Select [Boring] from Settings menu.

2. Set the boring, shift, and range of needle bar.

3. Click [OK].
Thread Breakage Sensor

The sensor for thread breakage can be turned ON/OFF or the sensor sensitivity for each needle bar can be set.

- The sensitivity can be set within the range of 1 - 100. The smaller the value is, the higher the sensitivity is.

2. Click the head you want to disable the sensor and remove the check mark (√).
3. Adjust the sensor sensitivity.
4. Click [OK].


**Automatic Step Back**
Sets the number of stitches for automatic step back if thread breakage occurs.

- The number of stitches that can be set is from 0 to 255.
- Additional step-back can be made for sensitivity value of the thread breakage sensor.

2. Enter the number of stitches for automatic step back.
3. Click [OK].

**Automatic Hoop Feed**
Sets automatic hoop feed for a thread breakage.

1. Select [Automatic Hoop Feed] from Settings menu and put the check mark (√).
End of embroidery

Sets if the machine returns to the start point after end of embroidery.

1. Select [End of embroidery] from Settings menu.

2. Click the checkbox to put a check mark (√) when the machine returns to the start point after end of embroidery. Click [OK].
Mending
Sets the details of mending.

- Items and descriptions are as follows:

| Automatically reset breakage error | Error is automatically canceled when a thread breakage occurs. |

1. Select [Mending] from Settings menu.
2. Click [OK] when the items are set.

Adjustment value of the needle is set.

- The adjustment value is set at the increment of 0.1 mm.
- The setting range is -0.5 ~ 2 mm in X and Y directions.
- If the adjustment value is set too large, a pattern may be disfigured.
- For sewing to be close to a hoop, if the adjustment value is set too large, “Area Over” may occur while sewing and the operation may stop.

1. Select [Adjust] from Settings menu.

2. When setting is complete, click [OK].
Driving shaft
Speeds up the startup of the main shaft. Select this function when sewing thick material.

1. Select [Driving shaft] from Settings menu and check it.

Activate escape with pause
Sets whether to feed the hoop during temporary stop of the needle bars to change colors. Select this function when embroidering applique.

1. Select [Activate escape with pause] from Settings menu and check it.

For enabling escape, set pause for the needle bar. Refer to page 6-17 "Setting Ranges".
Short stitch speed reduction

Reduces speed when stitching in a designated pitch.

- The pitch can be designated between 0.0 and 2.0 mm in units of 0.1 mm.
- The speed can be set between 400 rpm and the maximum speed of the current hoop in units of 10 rpm.

1. Select [Short stitch speed reduction] from Settings menu.

2. Click [Reducing speed] to check it and click [OK] when items are set.
Thin / Thick Material
Changes the timing of needle drop and hoop movement.

- The timing can be switched for thick material or thin material.

1. Select [Thin / Thick material] from Settings menu.

2. Select thick or thin by moving the slide bar control. Click [OK] when it is set.

Clicking this button will set to thin / range: 1 / jog moving power up: no.
Area Trace

Select the outside shape of area tracing before starting sewing.

- The following two types can be selected. The selected outside shape is displayed on the screen.

![Rectangle](image1)

![Octagon](image2)

1. Select the outside shape of [Area trace] from Settings menu and check it.
# Default Settings

Resets changes of the machine setting to the default.

- **Items for setting and initialization are as follows:**

<table>
<thead>
<tr>
<th>Item</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speed Range</td>
<td>Automatically selects the value suitable for the hoop type.</td>
</tr>
<tr>
<td>Hoop Feed Position</td>
<td>Returns to the machine home position.</td>
</tr>
<tr>
<td>Embroidering Area</td>
<td>Sets the size each for the selected hoop.</td>
</tr>
<tr>
<td>Thread Trimming</td>
<td>Inching motion</td>
</tr>
<tr>
<td></td>
<td>Thread removal feed length</td>
</tr>
<tr>
<td></td>
<td>Thread remaining amount</td>
</tr>
<tr>
<td>Thread Breakage Sensor</td>
<td>All sensors are on.</td>
</tr>
<tr>
<td></td>
<td>Sensitivity</td>
</tr>
<tr>
<td>Automatic Step Back</td>
<td>0</td>
</tr>
<tr>
<td>Thread Breakage Sensor Sensitivity</td>
<td>Not affected by the thread breakage sensor sensitivity</td>
</tr>
<tr>
<td>Automatic Feed Hoop</td>
<td>No</td>
</tr>
<tr>
<td>Return to the start point</td>
<td>Yes</td>
</tr>
<tr>
<td>Mending</td>
<td>Automatically rest breakage error</td>
</tr>
<tr>
<td>Adjustment</td>
<td>0.0 mm for X direction</td>
</tr>
<tr>
<td></td>
<td>0.0 mm for Y direction</td>
</tr>
<tr>
<td>Main shaft speed up setting</td>
<td>Activating speed up of driving shaft</td>
</tr>
<tr>
<td>Hoop feed during temporary stop</td>
<td>No</td>
</tr>
<tr>
<td>Reducing speed in a small pitch</td>
<td>No</td>
</tr>
<tr>
<td>Thin / Thick material</td>
<td>Thin</td>
</tr>
<tr>
<td></td>
<td>Feed speed</td>
</tr>
<tr>
<td></td>
<td>Jog moving power up</td>
</tr>
<tr>
<td>Area Trace</td>
<td>&quot;4 corner&quot; is selected.</td>
</tr>
</tbody>
</table>
1. Select [Default Settings] from Settings menu.

2. Click [OK].

**Show Setting**
Shows the setting contents and defaults.

- The following items are shown:
  - Embroidery area
  - Enable inching
  - Hoop movement after thread trimming
  - Sensitivity
  - Backward steps
  - Automatic hoop feed
  - Return to the start point
  - Activating speed up of driving shaft
1. Select [Show Setting] from Settings menu.

2. After checking, check [OK].
Load Setting

Load the setting.

The set file has an extension of "ecm".

1. Select [Load setting] from Settings menu.

2. Select the folder and click [Open].
Save Setting
Saves the edit settings.

- Save the setting files with an extension of "ecm".

1. Change the setting.

2. Select [Save setting] from Settings menu.

3. Select the registration folder and put a file name.

4. Click [Save].
Load Hoop
Load the optional hoop displayed in "Hoop".

- The hoop file to be loaded has an extension of "ehp".
- The types and the shapes of hoop for loading are as follows:
  Note) Hoops that can be displayed include hoops supported for machines other than this machine. Hoops indicated with ◎ at the hoop type name can be attached to this machine (including optional hoops). Hoops without ◎ cannot be attached to this machine. Note that some hoops indicated with ◎ may be displayed out of the embroidering area.

### Round frame

<table>
<thead>
<tr>
<th>Hoop Type</th>
<th>Image</th>
<th>Hoop Type</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROUND_FRAME21.ehp</td>
<td><img src="ROUND_FRAME21.ehp" alt="Image" /></td>
<td>ROUND_FRAME25.ehp</td>
<td><img src="ROUND_FRAME25.ehp" alt="Image" /></td>
</tr>
<tr>
<td>ROUND_FRAME21.ehp</td>
<td><img src="W0839Q" alt="Image" /></td>
<td>ROUND_FRAME25.ehp</td>
<td><img src="W0840Q" alt="Image" /></td>
</tr>
</tbody>
</table>

### Square frame

<table>
<thead>
<tr>
<th>Hoop Type</th>
<th>Image</th>
<th>Hoop Type</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>◎ SQUARE_FRAME24X24.ehp</td>
<td><img src="SQUARE_FRAME24X24.ehp" alt="Image" /></td>
<td>SQUARE_FRAME45X23.ehp</td>
<td><img src="SQUARE_FRAME45X23.ehp" alt="Image" /></td>
</tr>
<tr>
<td>◎ SQUARE_FRAME24X24.ehp</td>
<td><img src="W0841Q" alt="Image" /></td>
<td>SQUARE_FRAME45X23.ehp</td>
<td><img src="W1692" alt="Image" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hoop Type</th>
<th>Image</th>
<th>Hoop Type</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQUARE_FRAME45X27.ehp</td>
<td><img src="SQUARE_FRAME45X27.ehp" alt="Image" /></td>
<td>SQUARE_FRAME45X32.ehp</td>
<td><img src="SQUARE_FRAME45X32.ehp" alt="Image" /></td>
</tr>
<tr>
<td>SQUARE_FRAME45X27.ehp</td>
<td><img src="W1693" alt="Image" /></td>
<td>SQUARE_FRAME45X32.ehp</td>
<td><img src="W1694" alt="Image" /></td>
</tr>
</tbody>
</table>

### Spider net frame

<table>
<thead>
<tr>
<th>Hoop Type</th>
<th>Image</th>
<th>Hoop Type</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPIDER_NET_FRAME05B-1.ehp</td>
<td><img src="SPIDER_NET_FRAME05B-1.ehp" alt="Image" /></td>
<td>SPIDER_NET_FRAME05B-2.ehp</td>
<td><img src="SPIDER_NET_FRAME05B-2.ehp" alt="Image" /></td>
</tr>
<tr>
<td>SPIDER_NET_FRAME05B-1.ehp</td>
<td><img src="W0845Q" alt="Image" /></td>
<td>SPIDER_NET_FRAME05B-2.ehp</td>
<td><img src="W1695" alt="Image" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hoop Type</th>
<th>Image</th>
<th>Hoop Type</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPIDER_NET_FRAME05B-3.ehp</td>
<td><img src="SPIDER_NET_FRAME05B-3.ehp" alt="Image" /></td>
<td>SPIDER_NET_FRAME05B-4.ehp</td>
<td><img src="SPIDER_NET_FRAME05B-4.ehp" alt="Image" /></td>
</tr>
<tr>
<td>SPIDER_NET_FRAME05B-3.ehp</td>
<td><img src="W1696" alt="Image" /></td>
<td>SPIDER_NET_FRAME05B-4.ehp</td>
<td><img src="W1697" alt="Image" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hoop Type</th>
<th>Image</th>
<th>Hoop Type</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPIDER_NET_FRAME07B-1.ehp</td>
<td><img src="SPIDER_NET_FRAME07B-1.ehp" alt="Image" /></td>
<td>SPIDER_NET_FRAME07B-2.ehp</td>
<td><img src="SPIDER_NET_FRAME07B-2.ehp" alt="Image" /></td>
</tr>
<tr>
<td>SPIDER_NET_FRAME07B-1.ehp</td>
<td><img src="W0853Q" alt="Image" /></td>
<td>SPIDER_NET_FRAME07B-2.ehp</td>
<td><img src="W1698" alt="Image" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hoop Type</th>
<th>Image</th>
<th>Hoop Type</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPIDER_NET_FRAME07B-3.ehp</td>
<td><img src="SPIDER_NET_FRAME07B-3.ehp" alt="Image" /></td>
<td>SPIDER_NET_FRAME07B-4.ehp</td>
<td><img src="SPIDER_NET_FRAME07B-4.ehp" alt="Image" /></td>
</tr>
<tr>
<td>SPIDER_NET_FRAME07B-3.ehp</td>
<td><img src="W1699" alt="Image" /></td>
<td>SPIDER_NET_FRAME07B-4.ehp</td>
<td><img src="W1700" alt="Image" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hoop Type</th>
<th>Image</th>
<th>Hoop Type</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPIDER_NET_FRAME07T-1.ehp</td>
<td><img src="SPIDER_NET_FRAME07T-1.ehp" alt="Image" /></td>
<td>SPIDER_NET_FRAME07T-2.ehp</td>
<td><img src="SPIDER_NET_FRAME07T-2.ehp" alt="Image" /></td>
</tr>
<tr>
<td>SPIDER_NET_FRAME07T-1.ehp</td>
<td><img src="W0849Q" alt="Image" /></td>
<td>SPIDER_NET_FRAME07T-2.ehp</td>
<td><img src="W1701" alt="Image" /></td>
</tr>
</tbody>
</table>
Chapter 6  Embroidering

- SPIDER_NET_FRAME07T-3.ehp
- SPIDER_NET_FRAME07T-4.ehp

- SPIDER_NET_FRAME09T-1.ehp
- SPIDER_NET_FRAME09T-2.ehp

- SPIDER_NET_FRAME09T-3.ehp
- SPIDER_NET_FRAME09T-4.ehp

- SPIDER_NET_FRAME10B-1.ehp
- SPIDER_NET_FRAME10B-2.ehp

- SPIDER_NET_FRAME10B-3.ehp
- SPIDER_NET_FRAME10B-4.ehp

- SPIDER_NET_FRAME12T-1.ehp
- SPIDER_NET_FRAME12T-2.ehp

- SPIDER_NET_FRAME12T-3.ehp
- SPIDER_NET_FRAME12T-4.ehp

- SPIDER_NET_FRAME13B-1.ehp
- SPIDER_NET_FRAME13B-2.ehp

- SPIDER_NET_FRAME13B-3.ehp
- SPIDER_NET_FRAME13B-4.ehp

- SPIDER_NET_FRAME15T-1.ehp
- SPIDER_NET_FRAME15T-2.ehp

- SPIDER_NET_FRAME15T-3.ehp
- SPIDER_NET_FRAME15T-4.ehp

- SPIDER_NET_FRAME16B-1.ehp
- SPIDER_NET_FRAME16B-2.ehp

- SPIDER_NET_FRAME16B-3.ehp
- SPIDER_NET_FRAME16B-4.ehp
### Chapter 6  Embroidering

<table>
<thead>
<tr>
<th>Frame Type</th>
<th>Model Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spider Net Frame</td>
<td>SPIDER_NET_FRAME18T-1.ehp</td>
</tr>
<tr>
<td></td>
<td>SPIDER_NET_FRAME18T-2.ehp</td>
</tr>
<tr>
<td></td>
<td>SPIDER_NET_FRAME18T-3.ehp</td>
</tr>
<tr>
<td></td>
<td>SPIDER_NET_FRAME18T-4.ehp</td>
</tr>
<tr>
<td></td>
<td>SPIDER_NET_FRAME19B.ehp</td>
</tr>
</tbody>
</table>

#### Tubular Frame

<table>
<thead>
<tr>
<th>Model Number</th>
<th>Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>◎ TUBULAR_FRAME-05.ehp</td>
<td><img src="image1" alt="Diagram" /></td>
</tr>
<tr>
<td>◎ TUBULAR_FRAME-07.ehp</td>
<td><img src="image2" alt="Diagram" /></td>
</tr>
<tr>
<td>◎ TUBULAR_FRAME-10.ehp</td>
<td><img src="image3" alt="Diagram" /></td>
</tr>
<tr>
<td>◎ TUBULAR_FRAME-13.ehp</td>
<td><img src="image4" alt="Diagram" /></td>
</tr>
<tr>
<td>◎ TUBULAR_FRAME-16.ehp</td>
<td><img src="image5" alt="Diagram" /></td>
</tr>
<tr>
<td>◎ TUBULAR_FRAME-19.ehp</td>
<td><img src="image6" alt="Diagram" /></td>
</tr>
<tr>
<td>◎ TUBULAR_FRAME23X24.ehp</td>
<td><img src="image7" alt="Diagram" /></td>
</tr>
<tr>
<td>◎ TUBULAR_FRAME23X43.ehp</td>
<td><img src="image8" alt="Diagram" /></td>
</tr>
<tr>
<td>◎ TUBULAR_FRAME28X30.ehp</td>
<td><img src="image9" alt="Diagram" /></td>
</tr>
<tr>
<td>◎ TUBULAR_FRAME30X28.ehp</td>
<td><img src="image10" alt="Diagram" /></td>
</tr>
<tr>
<td>◎ TUBULAR_FRAME30X43.ehp</td>
<td><img src="image11" alt="Diagram" /></td>
</tr>
<tr>
<td>◎ TUBULAR_FRAME30X48.ehp</td>
<td><img src="image12" alt="Diagram" /></td>
</tr>
<tr>
<td>◎ TUBULAR_FRAME40X43.ehp</td>
<td><img src="image13" alt="Diagram" /></td>
</tr>
</tbody>
</table>

#### Holder Base Frame

<table>
<thead>
<tr>
<th>Model Number</th>
<th>Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>HOLDER_BASE23X24.ehp</td>
<td><img src="image14" alt="Diagram" /></td>
</tr>
<tr>
<td>HOLDER_BASE23X43.ehp</td>
<td><img src="image15" alt="Diagram" /></td>
</tr>
<tr>
<td>Tubular round frame</td>
<td></td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>TUBULAR_ROUND07.ehp</td>
<td>TUBULAR_ROUND09.ehp</td>
</tr>
<tr>
<td>TUBULAR_ROUND07.ehp</td>
<td>TUBULAR_ROUND09.ehp</td>
</tr>
<tr>
<td>TUBULAR_ROUND07.ehp</td>
<td>TUBULAR_ROUND09.ehp</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cap frame semi-wide frame</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CAP_FRAME_SEMI_WIDE.ehp</td>
<td></td>
</tr>
<tr>
<td>CAP_FRAME_SEMI_WIDE.ehp</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cap frame wide frame</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CAP_FRAME_WIDE.ehp</td>
<td></td>
</tr>
<tr>
<td>CAP_FRAME_WIDE.ehp</td>
<td></td>
</tr>
</tbody>
</table>
1. Select [Load hoop] from Settings menu.

2. Select the folder and click [Open].
Embroidering

How to start embroidering and operation after the start are explained here.

Starting Embroidering

- The following screen appears when the edit data is retrieved from the explorer.

1. Click .

When sewing start position differs from current needle position, "Hoop" appears at the machine display window.

Click to move the hoop to the sewing start position.
2. Press the \( \text{START} \) button.

   Embroidering starts.
   Embroidery data appears in gray, indicating the embroidering status.

![Embroidery data appears in gray](image)

**Pause**

1. Click \( \text{Pause} \).

**Canceling**

1. Press the \( \text{Pause} \) button while pressing the \( \text{STOP/RESET} \) button on the machine operation panel.

2. Click \( \text{Cancel} \).

3. The check screen appears. Click [Yes] to cancel.
Chapter 6  Embroidering

Moving the Home Position

Move the selected machine home position.

1. Select [Home Position] from Operation menu or click  


Step-forward/Step-back

Allows step-forward or step-back of stitches without embroidering.

- Click \( \text{to stop embroidering for step-forward/back mode.} \)
- The special tool bar appears in the step-forward/back mode.

Entering in the Step-forward/Step-back Mode

1. Click \( \text{to stop embroidering.} \)

2. Select [Step F/B] from the Operation menu or click \( \text{.} \)

A cross appears on the screen. The current needle position is the intersection of the vertical and horizontal lines.
Canceling step-forward/step-back

1. Click \( oxed{\times} \) of the step forward/back tool bar. The cross disappears and the step forward/back mode is canceled.

Setting Step-forward/Back Distance or Timing

Select step-forward/back distance or timing.

- The functions of icons are as follows:

<table>
<thead>
<tr>
<th>1</th>
<th>10</th>
<th>100</th>
<th>▴</th>
<th>▴</th>
</tr>
</thead>
</table>

- 1 Moves forward (backward) by 1 stitch.
- 10 Moves forward (backward) by 10 stitches.
- 100 Moves forward (backward) by 100 stitches.
- ▴ Moves to the next (previous) color change.
- ▴ Moves to the next (previous) feed.

1. Click the icon to select the desired function.
Stepping Forward/Back
Steps forward/back the stitches actually.

The functions of icons are as follows:

- **S** Returns to the start position. For repeating patterns, returns to the start position of the current pattern.
- **W0927Q**
- **W1162Q**
- **W1163Q**
- **W1164Q**
- **W1163Q**
- **W1164Q**

Click the **S** icon and the needle moves to the start position of the next repeating pattern.

Specify the travel length from the embroidery start point.

Selection of movement to the start position. The needle moves as follows:
1. Select the icon and move the cross to the desired position for step forward/back.

![Forward](W1165Q) ![Backward](W1166Q)

**Specifying the Value**
Specify the travel length from the embroidery start point.

1. Click ![specify](W1167Q).

2. Input the number of stitches to start embroidery. Click [OK].

**Resuming Embroidering**

1. Click ![resume](W1168Q) in the tool bar.
   
The cross disappears. The embroidery status at the step forward/backward position of the stitches is displayed.

![Forward](W1169Q) ![Backward](W1169Q)

2. Click ![resume](W1170Q).
   
   It is ready to resume embroidering and "Hoop" appears at the machine display window.

3. Press ![start](W1171Q) on the machine.
Moving Embroidery Position

Changes the position of embroidery data.

- Movement is allowed only in the embroidering area (within the red frame).

1. Select [Move Embroidery Position] from Operation menu or click  

2. The pointer turns into  Drag the embroidery data.  
   The mouse arrow becomes + while dragging.
Chapter 6  Embroidering

Centering Pattern

Moves the pattern to the machine home position.


![Image of machine control interface]

2. The pattern is moved.

![Image of pattern being moved]

W1173Q
Saving Data

Saves the edited data. The edited data can be saved over the current file or renamed as a separate file.

Save

Saves the edited data over the current file. The original data is deleted.

1. Select [Save] from File menu or click ![Save](image).

2. If color etc. has been is changed, the pattern image appears.

Save As...

Renames and saves the edited data as a new file.

1. Select [Save as...] from File menu.

2. Select the directory to save the new file. Enter a new file name.

3. Click [Save].

4. If color etc. has been is changed, the pattern image appears.
Running Other Programs

Other programs can be started when the machine power is not turned on or when the machine is in operation for embroidery.

- The following programs can be started:

<table>
<thead>
<tr>
<th>Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Embroidery data explorer</td>
<td>Allows transfer and copy of the embroidery data. Data transfer to the machine controller is not allowed.</td>
</tr>
<tr>
<td>Embroidery data editor</td>
<td>Allows editing of embroidery data.</td>
</tr>
<tr>
<td>Production report</td>
<td>Allows display and print-out of production data, etc.</td>
</tr>
</tbody>
</table>

1. Select [Embroidery Data Explorer independently] or [Embroidery Data Editor independently] from Tool menu.

Selecting [Embroidery Data Edit Individual Start]
- Input the number of needle bars. Input the number according to your machine specifications. Click [OK].

Click this to increase or decrease the value.
Chapter 7  Operation of Machine
1. Operating Procedures

1-1 Power Source

1. Turn the power on to the machine.
2. When the machine is equipped with the shut-off switch unit, Reset the emergency stop button.
3. When the machine is equipped with the shut-off switch unit, Press the power switch.
4. The power lamp lights up and a message is displayed on the LCD.

• The alarm sounds three times and the presser foot move upward. Then the hoop moves to the zero point and the sewing data screen is displayed.

Note) When turning the power off and back it on again, wait for at least 10 seconds.

1-2 Preparation for Embroidering

1. Select embroidering data while the machine is in the waiting state for an embroidering data selection, and transmit required data by pressing the icon.
2. The READY lamp lights up and the machine is placed in the waiting state.
3. Pressing , determine a position to start embroidering.
   An error code is displayed in the display window if a pattern comes out of the hoop.
4. Pressing starts embroidering.
   During embroidering, the speed is indicated in the display window.
5. After embroidering is finished, the machine is placed in the stand-by state.
Chapter 7 Operation of Machine

2. Machine Stop

2-1 Stopping the Machine with the stop switch unit

Press the stop switch (option) or to stop the operation of the machine. The stop switch adopts the push-lock method.

■ Resetting Machine Stop

- When the stop switch (option) is locked, the message "STOP" is displayed while binking on the operation panel.
- To reset the stop switch, turn it counterclockwise. The knob of the switch pops up and machine stop is reset.

2-2 Emergency Stop of the Machine with the shut-off switch unit

When the emergency stop switch is pressed, all power except that for the fluorescent lamp is turned off.

■ Resetting Emergency Stop (shut-off)

When turning the emergency stop switch in the direction of the arrow illustrated on the switch, the knob of the switch pops up and emergency stop is reset.

Press the power switch to turn on the power again.
3. Permission for Hoop Movement

When the computer has given a command to move the embroidery hoop, "HOOP" is displayed while blinking on the operation panel.

Press \( \text{[ ]} \) and the embroidery hoop moves to the designated position.
4. Jog Switches

4-1 Hoop Movement to Start Position

The hoop can be moved before starting embroidering and the start position can be set arbitrarily.
5. Area Check

5-1 External Tracing

If [button] is pressed in other cases than "area over", the rectangular outline of the pattern is traced.

5-2 Automatic Hoop Movement in Area

• If "area over" is displayed, press [button]. The hoop automatically moves inside the embroidering area, where the pattern is set, at the nearest position.
• After finishing the movement inside the area by this function, execute external tracing. Then, check that the needle and the presser foot do not interfere with the hoop before starting embroidering.
• If the pattern is not held in the embroidering area as shown below, the hoop cannot move into the area. To enlarge the embroidering area, refer to Page 6-29 “Embroidery Area”.

[Diagrams of embroidery areas and movement positions]
6. Hoop Feed Position

- In order to ease mounting and dismounting of the embroidery hoop, another needle position can be set as a hoop feed position in the movable area additionally to the current needle position. Refer to "Hoop Feed Position" on Page 6-28 for details.

- In order to ease material attachment while operation is suspended, the hoop can be moved to the feed position at any time by the hoop feed switch.

- The hoop can also be moved to the feed position automatically after embroidering is finished. Refer to "Automatic Hoop Feed" on Page 6-34 for details.

1. Press 🛠️.
7. Measures against Thread Breakage

7-1 Remedies

1. If embroidering is suspended due to thread breakage, “E-0A” is displayed while blinking on the operation panel.

2. Correct the broken thread and pass it through again.
   Refer to "Chapter 2, 3-1 Upper Threading" (→ Page 2-12) for details.

3. Press the switch in order to reset the alarm of thread breakage.

4. Return the hoop to a position where thread breakage occurred by pressing the STEP BACK switch.

   When the switch is pressed, the machine continues operation without holding the switch. To stop the machine, press the switch to the opposite side or press the switch.

5. Press the switch to resume operation.
8. Inching Mode

8-1 Inching Mode during Embroidering (Forcible Hoop Movement)

- Moving the frame greatly in the inching mode may cause an interference with the machine. Pay utmost care in the inching mode.
- Although the distance of the frame moved in the inching mode is stored even after turning OFF the power, if the power is turned ON again and sewing is started, the pattern may be embroidered in a different position. Be sure to use the inching mode appropriately.

1. Press \( \downarrow \) while pressing \( \Rightarrow \), "Jog" is displayed.
2. Press \( \Rightarrow \) and press the \( \langle \rangle \). The hoop moves to the direction of the pressed switch.
   • Note that the forcible hoop movement will produce deviation of embroidering by the amount.
   • If the hoop and material are deviated from each other during embroidering, correct it by using the jog switches.
3. Pressing \( \Rightarrow \) resets the inching mode.
4. Press \( \Rightarrow \) restarts embroidering.
Chapter 8
Creating Production Report

Records and controls the machine operation. The production report can be created based on this data. Detailed information of production report allows efficient embroidering control.
## Functions (Command Reference)

### File menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Report File</td>
<td>Opens the report file. ([→ page 8-4])</td>
</tr>
<tr>
<td>Save As CSV</td>
<td>Saves the current report data in CSV format. ([→ page 8-18])</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the report. ([→ page 8-19])</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Displays the print preview on the screen.</td>
</tr>
<tr>
<td>Page Setup</td>
<td>Displays the setting screen for printing. ([→ page 8-19])</td>
</tr>
<tr>
<td>Exit from Production Report</td>
<td>Exits from the production report.</td>
</tr>
</tbody>
</table>

### Edit menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies the selected area to the clipboard. ([→ page 8-20])</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all report data.</td>
</tr>
</tbody>
</table>

### View menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>Displays detail data. ([→ page 8-5])</td>
</tr>
<tr>
<td>Thread Breakage Information on Needle Bar</td>
<td>Displays the thread breakage information for each machine needle. ([→ page 8-6])</td>
</tr>
<tr>
<td>Thread Breakage information in pattern</td>
<td>Displays the thread breakage information for each pattern. ([→ page 8-7])</td>
</tr>
<tr>
<td>Output information</td>
<td>Displays the production output of each machine. ([→ page 8-8])</td>
</tr>
<tr>
<td>Total output information</td>
<td>Displays the total production output. ([→ page 8-10])</td>
</tr>
<tr>
<td>Display graph</td>
<td>Displays the information in graph.</td>
</tr>
<tr>
<td>Display text</td>
<td>Displays the information in text.</td>
</tr>
<tr>
<td>Top page</td>
<td>Displays the top page.</td>
</tr>
<tr>
<td>Previous page</td>
<td>Displays the previous page.</td>
</tr>
<tr>
<td>Next page</td>
<td>Displays the next page.</td>
</tr>
<tr>
<td>Last page</td>
<td>Displays the last page.</td>
</tr>
<tr>
<td>Tool Bar</td>
<td>Displays the tool bar.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Displays the status bar.</td>
</tr>
</tbody>
</table>

### Settings menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items to be displayed</td>
<td>Sets the display item. ([→ page 8-12])</td>
</tr>
</tbody>
</table>
Description of Screen

Thread Breakage for Each Needle Bar
Thread Breakage for Each Pattern
Detailed Data
Display graph
Save as CSV
Copy
Total Output
Display text
About This Application
Print
Help
Open report file

Details

Machine name: EMB-4
Collate: 06/01/01 - 08/31/01
Specified time: 00:00 - 00:00

Date     Time     Reason
06/01/01  18:45:48  Power ON
06/01/01  18:45:48  Load design Cott.ects No. of stitches=0003830
06/01/01  18:51:01  Embroidering started
06/01/01  18:51:36  Error
06/01/01  18:52:06  Embroidering restarted
06/01/01  18:52:20  Stoppage due to thread breakage Head No.5 Needle bar no.4
06/01/01  18:53:01  Embroidering restarted
06/01/01  18:57:18  Error
06/01/01  18:58:11  Embroidering restarted
06/01/01  18:58:46  Embroidering completed

**** **** Load design Cott.ects No. of stitches=0003830 (06/01/01 18:45:48)
06/01/01  18:00:08  Embroidering started
06/01/01  18:04:28  Stoppage due to thread breakage Head No.5 Needle bar no.4
06/01/01  18:05:00  Embroidering restarted
06/01/01  18:06:36  Embroidering completed

**** **** Load design Cott.ects No. of stitches=0003830 (06/01/01 18:45:48)

Status bar
W1177Q
Displaying Report

Displays the machine operation status in the form of report.

- The following reports can be displayed:

<table>
<thead>
<tr>
<th>Details</th>
<th>Displays detail data while the machine is in operation.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thread Breakage information on Needle Bar</td>
<td>Displays the thread breakage information for each machine.</td>
</tr>
<tr>
<td>Thread Breakage information in Pattern</td>
<td>Displays the thread breakage information for each pattern.</td>
</tr>
<tr>
<td>Output information</td>
<td>Displays production output or efficiency of the selected machine.</td>
</tr>
<tr>
<td>Total output information</td>
<td>Displays production output or efficiency of multiple machines.</td>
</tr>
</tbody>
</table>

- Items to be displayed in each report can be set. For details, refer to "Setting Display Items" (→ page 8-12).

1. Select the desired report from View menu or on the tool bar.
2. Select [Open] from File menu or click 📄.
3. Select the applicable machine.

   ![Open report file dialog box]

   Click here to select the machine for detail data, thread breakage and output information.

   Click here to select the machine for total output information. Click here again to cancel the selection.

4. Click [OK].
5. Specify the period to read.
   For more information, refer to "General" in "Setting Display Items" on page 8-12.
6. Click [OK].
   The report appears.
Display Example of Details
Displays the machine information chronologically that are collected within the specified period.

The following information is indicated under the "Reason" column:

<table>
<thead>
<tr>
<th>Display</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power ON</td>
<td>The machine power was turned on.</td>
</tr>
<tr>
<td></td>
<td>If the computer is turned on after the machine power has been on, it</td>
</tr>
<tr>
<td></td>
<td>shows the time when the computer recognized the machine.</td>
</tr>
<tr>
<td>Power OFF</td>
<td>The machine power was turned off.</td>
</tr>
<tr>
<td></td>
<td>If the computer is turned off before the machine power, it shows</td>
</tr>
<tr>
<td></td>
<td>the time when the computer program quit.</td>
</tr>
<tr>
<td>Load design (*)</td>
<td>The name of the loaded pattern and the number of stitches are</td>
</tr>
<tr>
<td></td>
<td>indicated. This is also recorded when embroidering was started after</td>
</tr>
<tr>
<td></td>
<td>the power was turned off and back on.</td>
</tr>
<tr>
<td>Embroidering started</td>
<td>Embroidering was started.</td>
</tr>
<tr>
<td>Embroidering completed</td>
<td>Embroidering was completed.</td>
</tr>
<tr>
<td>Embroidering canceled</td>
<td>Embroidering was canceled.</td>
</tr>
<tr>
<td></td>
<td>The information on the pattern is deleted from the record.</td>
</tr>
<tr>
<td>Color change (*)</td>
<td>The needle bar number and the number of stitches after color change</td>
</tr>
<tr>
<td></td>
<td>are indicated.</td>
</tr>
<tr>
<td>Suspended (*)</td>
<td>The machine operation was suspended by the operator.</td>
</tr>
<tr>
<td>Stoppage due to thread breakage (*)</td>
<td>A thread breakage occurred.  The head number, the needle bar</td>
</tr>
<tr>
<td></td>
<td>number and the speed range are indicated.</td>
</tr>
<tr>
<td>Error (*)</td>
<td>The machine was stopped due to an error.</td>
</tr>
<tr>
<td>Embroidering restarted (*)</td>
<td>Embroidering was restarted after a suspension, a thread breakage, or</td>
</tr>
<tr>
<td></td>
<td>an error.</td>
</tr>
</tbody>
</table>

The items marked with "*" can be shown or hidden on the "Setting items to be displayed" screen.
Display Example of Thread Breakage Information on Needle Bar

Displays the information on thread breakage occurrences with head numbers and needle bar numbers. Three needle bars with frequent thread breakage are indicated.

<table>
<thead>
<tr>
<th>Display</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. of times thread is trimmed (*)</td>
<td>Number of thread breakage occurrences per needle bar</td>
</tr>
<tr>
<td>No. of stitches (*)</td>
<td>Number of stitches embroidered with the needle bar during the specified period</td>
</tr>
<tr>
<td>Thread breakage rate (*)</td>
<td>Thread breakage rate per 10,000 stitches (10000 x No. of times thread is trimmed) /No. of stitches</td>
</tr>
<tr>
<td>Total (*)</td>
<td>Total for all the heads or all the needle bars</td>
</tr>
<tr>
<td>Needle bar with frequent thread breakage occurrence (*)</td>
<td>Three needle bars that have thread breakage frequently, in the decreasing order of frequency</td>
</tr>
</tbody>
</table>

The items marked with "*" can be shown or hidden on the "Setting items to be displayed" screen.

Display in text

Display in graph

The number of thread breakage for each head is displayed with the graph by needle bar.

Click tab to display the thread breakage rate with the graph.
Display Example of Thread breakage Information in Pattern
Displays thread breakage information for each pattern.

<table>
<thead>
<tr>
<th>Display</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>n th</td>
<td>The pattern was embroidered for the &quot;n&quot;th time.</td>
</tr>
<tr>
<td>Pattern name</td>
<td>Name of the pattern that was embroidered</td>
</tr>
<tr>
<td>Head No. (*)</td>
<td>Head number where a thread breakage occurred</td>
</tr>
<tr>
<td>Needle bar no. (*)</td>
<td>Needle bar number where a thread breakage occurred</td>
</tr>
<tr>
<td>n th stitch (*)</td>
<td>The ordinal number of the stitch when a thread breakage occurred</td>
</tr>
<tr>
<td>Speed range (*)</td>
<td>Speed range that was effective when a thread breakage occurred</td>
</tr>
</tbody>
</table>

The items marked with "*" can be shown or hidden on the "Setting items to be displayed" screen.

Display in text

![Display in text](W1181Q)

Display in graph
The number of thread breakage for each pattern is displayed with the graph.

![Display in graph](W1182Q)

Click tab to display other patterns with the graph.
Display Example of Output Information
Displays the production information that are collected during the specified period.

<table>
<thead>
<tr>
<th>Display</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total electricity supply time</td>
<td>Total time when the machine was energized within the specified period(**)</td>
</tr>
<tr>
<td>Total embroidering time</td>
<td>Total time when the machine embroidered within the specified period</td>
</tr>
<tr>
<td>Total actual embroidering time</td>
<td>Total actual time when the machine embroidered within the specified period</td>
</tr>
<tr>
<td>Excluded time</td>
<td>Total time of intermission and maintenance for the number of days in the specified period</td>
</tr>
<tr>
<td>Electricity supply efficiency</td>
<td>Electricity supply efficiency by calculating below:</td>
</tr>
<tr>
<td></td>
<td>(Total electricity supply time - excluded time) / total electricity supply time</td>
</tr>
<tr>
<td>Embroidering efficiency period</td>
<td>Ratio of the actual embroidering time to the total embroidering time</td>
</tr>
<tr>
<td></td>
<td>Total actual embroidering time / total embroidering time</td>
</tr>
<tr>
<td>Number</td>
<td>The pattern embroidered during the specified period is numbered.</td>
</tr>
<tr>
<td>Pattern name</td>
<td>Name of the pattern</td>
</tr>
<tr>
<td>No. of stitches in pattern</td>
<td>Number of stitches in the pattern</td>
</tr>
<tr>
<td>Total stitches (*)</td>
<td>Total number of stitches by repeating embroidering</td>
</tr>
<tr>
<td></td>
<td>No. of stitches in pattern X No. of times embroidered</td>
</tr>
<tr>
<td>No. of colors in pattern (*)</td>
<td>Number of colors in the pattern</td>
</tr>
<tr>
<td>No. of times embroidered (*)</td>
<td>Number of embroidering repeated</td>
</tr>
<tr>
<td>No. of workpieces embroidered (*)</td>
<td>Number of finished sheets by one embroidering cycle</td>
</tr>
<tr>
<td>Total no. of heads which are stopped</td>
<td>Total number of the heads at rest for one embroidering cycle</td>
</tr>
<tr>
<td>Embroidering time (*)</td>
<td>Time from embroidering start to the end for the pattern</td>
</tr>
<tr>
<td>Actual embroidering time (*)</td>
<td>Embroidering time from which the time for interruption, stop due to thread breakage, and stop due to error is excluded</td>
</tr>
<tr>
<td>Average embroidering speed</td>
<td>Average embroidering speed in the actual embroidering time (the number of stitches per minute)</td>
</tr>
<tr>
<td></td>
<td>Total stitches/actual embroidering time</td>
</tr>
<tr>
<td>Efficiency 1 (*)</td>
<td>Ratio of the actual embroidering time to the embroidery time for the pattern with time for interruption excluded</td>
</tr>
<tr>
<td></td>
<td>Actual embroidering time/(embroidering time-time for interruption)</td>
</tr>
<tr>
<td>Efficiency 2 (*)</td>
<td>Ratio of the actual embroidering time to the embroidery time</td>
</tr>
<tr>
<td></td>
<td>Actual embroidering time / embroidery time</td>
</tr>
<tr>
<td>Time stopped (*)</td>
<td>Total of stop time during embroidering</td>
</tr>
<tr>
<td>Reason for stoppage (*)</td>
<td>Reasons for stoppage are indicated. Refer to the next page.</td>
</tr>
</tbody>
</table>

The items marked with "*" can be shown or hidden on the "Setting items to be displayed" screen.
**) Electricity supply time is totaled per one day.
Details of reason for stoppage

<table>
<thead>
<tr>
<th>Reason</th>
<th>Frequency and total time stopped by the operator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interrupted</td>
<td>Frequency and total time stopped by the operator</td>
</tr>
<tr>
<td>Stoppage due to thread breakage</td>
<td>Frequency and total time stopped by thread breakage</td>
</tr>
<tr>
<td>Error</td>
<td>Frequency and total time stopped by errors</td>
</tr>
</tbody>
</table>

Display in text

![Text-based display of embroidery efficiency](image1)

Display in graph

The output information is displayed with the graph.

Displayed here is the screen of embroidering efficiency.

![Graph-based display of embroidery efficiency](image2)

Click tab to display the total embroidering time, etc, with the graph.
Display Example of Total Output Information
Displays the output information per pattern on multiple machines that are selected.

<table>
<thead>
<tr>
<th>Display</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The pattern embroidered during the specified period is numbered.</td>
</tr>
<tr>
<td>Pattern name</td>
<td>Name of the pattern</td>
</tr>
<tr>
<td>No. of stitches in pattern</td>
<td>Number of stitches in the pattern</td>
</tr>
<tr>
<td>Total stitches (*)</td>
<td>Total number of stitches by repeating embroidering No. of stitches in pattern X No. of times embroidered</td>
</tr>
<tr>
<td>No. of colors in pattern (*)</td>
<td>Number of colors in the pattern</td>
</tr>
<tr>
<td>No. of times embroidered (*)</td>
<td>Number of embroidering repeated</td>
</tr>
<tr>
<td>No. of workpieces embroidered (*)</td>
<td>Number of finished sheets by one embroidering cycle</td>
</tr>
<tr>
<td>Total no. of heads which are stopped</td>
<td>Total number of the heads at rest for one embroidering cycle</td>
</tr>
<tr>
<td>Embroidering time (*)</td>
<td>Time from embroidering start to the end for the pattern</td>
</tr>
<tr>
<td>Actual embroidering time (*)</td>
<td>Actual embroidering time excluding the stop time by thread breakage, suspension and errors from the embroidering time</td>
</tr>
<tr>
<td>Actual embroidering speed (*)</td>
<td>Average embroidering speed in the actual embroidering time (the number of stitches per minute) Total stitches/actual embroidering time</td>
</tr>
<tr>
<td>Efficiency 1 (*)</td>
<td>Ratio of the actual embroidering time to the embroidering time for the pattern with time for interruption excluded Actual embroidering time/(embroidering time-time for interruption)</td>
</tr>
<tr>
<td>Efficiency 2 (*)</td>
<td>Ratio of the actual embroidering time to the embroidering time Actual embroidering time / embroidering time</td>
</tr>
<tr>
<td>Time stopped (*)</td>
<td>Total of stop time during embroidering</td>
</tr>
<tr>
<td>Reason for stoppage (*)</td>
<td>Reasons for stoppage are indicated. Refer to page 8-9.</td>
</tr>
</tbody>
</table>

The items marked with "*" can be shown or hidden on the "Setting items to be displayed" screen.
**Display in graph**
The total output information is displayed with the graph.
Displayed here is the screen of the number of embroidered cloths.

Click tab to display the total embroidering time, etc, with the graph.
Chapter 8  Creating Production Report

Setting Display Items

Sets display items for each production report.

- The following tab windows can be set:

<table>
<thead>
<tr>
<th>Tab Window</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Items related to the overall display of the output report.</td>
</tr>
<tr>
<td>Details</td>
<td>Items related to detail data.</td>
</tr>
<tr>
<td>Thread Breakage information on Needle Bar</td>
<td>Items related to thread breakage for each needle bar.</td>
</tr>
<tr>
<td>Thread Breakage information in Pattern</td>
<td>Items related to thread breakage for each pattern.</td>
</tr>
<tr>
<td>Output information</td>
<td>Items related to output information.</td>
</tr>
<tr>
<td>Total output information</td>
<td>Item related to total output information.</td>
</tr>
<tr>
<td>Recess time setting</td>
<td>Items not included in the efficiency calculation for output information and total output information.</td>
</tr>
</tbody>
</table>

1. Select [Items to be displayed] from Settings menu.
2. "Setting items to be displayed" screen appears.
   Click the tab on the screen and the tab window for the items appears.

![General Tab](W1187Q)
Collate
Selects the data collection period. If month, week or day is selected, set the end date or end hour.

Storage
Selects the data save period.

Details

Main items to be displayed
Displays each event and the time.

<table>
<thead>
<tr>
<th>Event</th>
<th>Time/Moment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load design</td>
<td>Transfer time of embroidery data</td>
</tr>
<tr>
<td>Color change</td>
<td>Time of color change</td>
</tr>
<tr>
<td>Stoppage due to thread breakage</td>
<td>Time of thread breakage</td>
</tr>
<tr>
<td>Restart</td>
<td>Time of resuming embroidering after suspension</td>
</tr>
<tr>
<td>Stop after pressing button</td>
<td>Time when the emergency stop button was pressed</td>
</tr>
<tr>
<td>Suspended Error</td>
<td>Time when an error has occurred</td>
</tr>
</tbody>
</table>

Sub items to be displayed
Displays the following for each item in main display items.

<table>
<thead>
<tr>
<th>Item</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Head no.</td>
<td>Head number</td>
</tr>
<tr>
<td>Needle no.</td>
<td>Needle number</td>
</tr>
<tr>
<td>No. of stitches</td>
<td>Number of stitches</td>
</tr>
<tr>
<td>Speed range</td>
<td>Speed range</td>
</tr>
</tbody>
</table>
Thread Breakage Information on Needle Bar

Main items to be displayed

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. of thread breakage occurrences</td>
<td>Number that thread breakage has occurred</td>
</tr>
<tr>
<td>No. of stitches</td>
<td>Number of stitches used in embroidery</td>
</tr>
<tr>
<td>Thread breakage rate</td>
<td>Rate of thread breakage for 10,000 stitches</td>
</tr>
</tbody>
</table>

Sub items to be displayed

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total</td>
<td>Total of the item for each head and each needle</td>
</tr>
<tr>
<td>Needle Bar with frequent thread breakage occurrences</td>
<td>Data of three needles that have caused thread breakage most frequently</td>
</tr>
</tbody>
</table>

Thread Breakage Information in Pattern

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Head no. where thread breakage occurred</td>
<td>Head number that has caused thread breakage</td>
</tr>
<tr>
<td>Needle bar no. where thread breakage occurred</td>
<td>Needle number that has caused thread breakage</td>
</tr>
<tr>
<td>No. of stitches until thread breakage</td>
<td>Number of stitches until thread breakage has occurred</td>
</tr>
<tr>
<td>Speed range</td>
<td>Speed range when thread breakage has occurred</td>
</tr>
</tbody>
</table>
Output Information

Time is calculated to the unit of second, but the display unit is in minute. This may result in minor differences.

**Items to be displayed**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total stitches</td>
<td>The total number of embroidery stitches from start to end</td>
</tr>
<tr>
<td>No. of times embroidered</td>
<td>Number of embroidering</td>
</tr>
<tr>
<td>Embroidering time</td>
<td>The total time from start to end spent for embroidery</td>
</tr>
<tr>
<td>Actual embroidering time</td>
<td>Time spent for embroidering</td>
</tr>
<tr>
<td>Time stopped</td>
<td>Time not spent for embroidering</td>
</tr>
<tr>
<td>Embroidering efficiency</td>
<td>Actual embroidery time / (Embroidering time - Interrupted)</td>
</tr>
<tr>
<td>Reason for stoppage</td>
<td>Event that caused a stop</td>
</tr>
<tr>
<td>No. of colors in pattern</td>
<td>Number of colors in pattern</td>
</tr>
<tr>
<td>No. of workpieces embroidered</td>
<td>Number of sheets embroidered.</td>
</tr>
<tr>
<td>Average embroidering speed</td>
<td>Number of total stitches / Actual embroidery time</td>
</tr>
<tr>
<td></td>
<td>(number of stitches for 1 minute in embroidering)</td>
</tr>
</tbody>
</table>

**Reason for stoppage**

Items for selection appear when [Reason for Stoppage] is clicked in the "Items to be displayed" column. The display shows for three cases: emergency button stop, thread breakage, and error stop.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Times</td>
<td>Number of stops</td>
</tr>
<tr>
<td>Total time</td>
<td>Total stop time</td>
</tr>
<tr>
<td>Average time</td>
<td>Average stop time per occurrence (in seconds)</td>
</tr>
</tbody>
</table>
Total Output Information

Time is calculated to the unit of second, but the display unit is in minute. This may result in minor differences.

- **Items to be displayed**
  - **Total stitches**: The total number of embroidery stitches from start to end
  - **No. of times embroidered**: Number of embroidering
  - **Embroidering time**: The total time from start to end spent for embroidery
  - **Actual embroidering time**: Time spent for embroidering
  - **Time stopped**: Time not spent for embroidering
  - **Embroidering efficiency**: Actual embroidery time/ (Embroidering time-Interrupted) Actual embroidery time/Embroidering time (in %)
  - **Reason for stoppage**: Event that caused a stop
  - **No. of colors in pattern**: Number of colors in pattern
  - **No. of workpieces embroidered**: Number of sheets embroidered.
  - **Average embroidering speed**: Number of total stitches/Actual embroidery time (number of stitches for 1 minute in embroidering)

- **Reason for stoppage**
  Items for selection appear when [Reason for Stoppage] is clicked in the "Items to be displayed" column.
  The display shows for three cases: emergency button stop, thread breakage, and error stop.

- **Target machine**
  Click and select the machine for calculation. To cancel the selection, click again.
Recess Time Setting

Sets the time not to be included in the calculation. This time is displayed on the "Output" report as "Time Excluded".

- **Target machine**
  Click and select the applicable machine for calculation.

- **Total recess time**
  Set the time not to be included in the day-to-day calculation during the designated period.

- **Total maintenance time**
  Set the time not to be included in the calculation throughout the period.
Save As CSV...

Converts the production report data to CSV format that can be read in spreadsheet software.

1. Select [Save As CSV] from File menu or click 📋.
2. The file name "Untitled. csv" automatically appears. To change the name, change "Untitled".
3. Select the directory to be saved and click [Save].

What is CSV format?

CSV (Comma Separated Value format) means a type of file formats used for PC. Data in each item is divided by commas and recorded as a text file. This format is mainly used for a spreadsheet software or data base software. The extension is "csv".
Printing Production Report

Prints the production report from a printer.

Page Setup

Printing method is set as required.

   Setting screen is displayed.

   ![Page Setup Screen]

   - The sample image is displayed.
   - Set the margin.
   - Set the printer.
   - Set the paper direction.
   - Set the paper size.

Print

1. Select [Print] from File menu or click 
   Set the number of sheets and click [OK].
Chapter 8  Creating Production Report

Copying Report Data

Copies the selected area as text data. This allows use of the production report on other word processing software.

1. Select [Select All] from Edit menu, or drag and select the area to be copied.

   ![Image 1](image1)
   
   When dragging for selection

   ![Image 2](image2)
   
   When selecting [Select All]

2. Select [Copy] from Edit menu or click ![Copy icon]

3. The area is copied as text data. Start a word processing software and select [Paste] from Edit menu.
   Copied data is saved until another data is copied or cut.
Chapter 9  Maintenance
CAUTION

⚠️ Turn off the power switch before starting maintenance. Failure to do so may start the machine unintentionally through an accidental activation of the START switch, resulting in bodily injuries.

⚠️ Be sure to wear protective goggles and gloves when handling the lubricating oil or grease, so that no oil or grease gets into your eyes or onto your skin, otherwise inflammation can result. Furthermore, do not drink the oil or grease under any circumstances, as they can cause vomiting and diarrhoea. Keep the oil out of the reach of children.

• Keep the machine clean at all times to prevent machine trouble.
• Keep the machine clean.
  Remove dirt with a soft, dry cloth. If necessary, clean with the detergent-soaked cloth, then wipe off the detergent with a cloth dampened with (hot) water.
• Caution
  Never use benzene or thinner for cleaning the machine.

1. Cleaning

1-1 Cleaning and Lubrication of Rotary Hook

• Clean rotary hooks daily using the brush provided. If a rotary hook is too dirty, cleaning with a compressor (compressed air) is recommended.
• If thread breakage or rotary hook noise occurs during embroidering, lubricate the race of the rotary hook.
  Note) • Use the dropper provided to supply oil. Use BROTHER's embroidery machine oil (equivalent to Nisseki Sewing Lub No. 10).
  • Supply a proper amount of oil. Any excess may stain fabrics, etc.
1-2 Cleaning of Needle Plate

Broken threads left around the movable or fixed knives or the thread holding plate may result in thread trimming failure or parts damage. Clean them once a month.

Remove broken threads from this section.
2. Oiling

To extend the machine's service life, supply oil to the following places at regular intervals.

The models BE-0901E-AC-PC and BE-1201B-AC-PC adopt centralized wick lubrication (including rotary hooks). Before daily operation, supply oil as needed while checking the oil level through the oil window.

Note) • When oiling, be sure to supply Brother's machine oil (Nisseki Sewing Lube #10 or the equivalent) using the dropper.

• Excessive oiling may cause the material to be stained.

• Lubricate the rotary hook.

2-1 Head

■ When the machine has been unpacked or has not been used over a prolonged period

Supply 7 or 8 drops of oil to the points indicated by the arrows in the figure before starting operation.

■ BE-0901E-AC-PC

Supply oil to the top and the bottom of each needle bar (18 points) daily as shown in the figure.
Supply oil to the top and the bottom of each needle bar (24 points) daily as shown in the figure.

Note: • Refill the machine front tank with oil once a week.
  • The machine front tank may run dry in one or two hours. Since the tank contains an oil storage device, it lubricates the machine gradually even if the tank is empty.
Before operation.

Before starting operation of the machine, move the needle case fully to the right and the left, and use a cloth to wipe greasy dirt off the needle bar guide rail and the pressure foot shaft (indicated by the arrows in the figure) from the rear of the needle bar case.
Chapter 10  Adjustment
Chapter 10 Adjustment

**CAUTION**

- Turn off the power switch and pull out the plug before starting adjustment. Failure to do so may start the machine unintentionally through an accidental activation of the START switch, resulting in bodily injuries.
- If adjustment should be made while the power switch is turned on, pay special attention to your safety.
- Maintenance and inspection of the machine should be conducted only by trained engineers.

1. Adjusting Needle Bar Height

![Diagram showing needle bar adjustments]

- **[1]**
- **[2]**
- **[3]**
- **[4]**
- **[5]**
- **[6]**
- **[7]**
- **[8]**

Tighten the bolt [7] so that the clearance can be even.

Do not hit this section.

10.8mm

W1619

W1620

W1621

W1622

W1623

Note: Illustrations and diagrams may show dimensions and positions for illustrative purposes only.

---

10-2  "BE-0901E-AC-PC • BE-1201B-AC-PC"
1. Dismount the pulley cover and turn the pulley [1] until the pulley scale indicates 180° and the needle bar is set at the lowest position. (The pulley ‘’’ mark and the stop mark ‘’’ are aligned.)

2. Insert the positioning bar [2] into the hole of the pulley [1] and fix the upper shaft.
   Note) Turn the pulley securely in the clockwise direction to eliminate a backlash.

   Note) When tightening the needle bar clamp set screw [3], the hole in the needle bar guide should face the front.

4. After adjustment is finished, remove the positioning bar [2].

5. Set the needle bar at the highest position (where the pulley indication mark ‘’’ and the cover indication mark ‘’’ are aligned). Lightly press the top dead center stopper [5] toward the cushion rubber [6], and tighten Socket head bolt for top dead center stopper [7] whilepressing down the needle bar clamp so that it faces the front.
   Note) Make sure that the top dead center stopper does not hit the needle bar guide rail [8] at this time.
When using the bottom dead center gauge

- Tighten the bolt [9] so that the clearance can be even.
- Do not hit this section.
1. Turn the pulley [1] until the scale of pulley [1] indicates 180° (where the pulley indication mark “I” and the stop mark “II” are aligned) and the needle bar is set at the lowest position.

2. Insert the positioning bar [2] into the hole of the pulley [1] and fix the upper shaft.
   Note) Turn the pulley securely in the clockwise direction.

3. Insert the bottom dead center gauge [3] into the rotary hook [4].

4. Loosen the screw [6] of the needle bar clamp [5], then move the needle bar up and down until the needle tip touches the gauge [3] lightly.
   Note) The needle point should touch the gauge at a place other than the cutting section.
   • The bottom dead center gauge should be set in or removed from the rotary hook with its cutting section facing upward.


6. After adjustment is finished, remove the positioning bar [2].

7. Set the needle bar at the highest position (where the pulley indication mark “I” and the cover indication mark “I” are aligned). Lightly press the top dead center stopper [7] toward the cushion rubber [8], and tighten Socket head bolt for top dead center stopper [9] while pressing down the needle bar clamp so that it faces the front.
   Note) Make sure that the top dead center stopper [7] does not hit the needle bar guide rail [10] at this time.
2. Adjustment of Timing Between Needle and Rotary Hook

1. Select needle bar No. 1.
   The above figure shows model BE-0901E-AC-PC. For model BE-1201B-AC-PC, needle bar No. 12
corresponds to y.

2. Remove two flat countersunk head screws [2], and remove needle plate [3].

3. Make an adjustment so that the needle is brought to rotary hook [4] when it rises 2 mm from the
   needle bar bottom point (180°) (in the position where the mark "O" of the pulley is aligned with the
   stop mark "O").

4. Loosen screws [5] of the rotary hook. Adjust the clearance between the needle and the rotary hook
to 0.2 to 0.4 mm. Tighten the two screws temporarily. The needle bar height will be about 2 mm
(Figure A).

5. Select the second needle bar (bar No. 12 for BE-1201B-AC-PC) [6]. Check that a clearance of 0.2
to 0.4 mm is left between the needle and the rotary hook. Tighten the three screws of the rotary
hook.

   Note) If the clearance between the needle and the rotary hook is not within 0.2 to 0.4 mm, repeat step 3
   and adjust both clearances at needle bar No. 1 and No. 9 (No. 12 for BE-1201B-AC-PC) to the
   range of 0.2 to 0.4 mm respectively. 9.
3. Adjustment of Presser Foot Height

1. Turn the power switch off.

2. Select the needle bar No. 1.

3. Loosen the screw [2] of the presser foot [1], and adjust the presser foot [1] until it comes above the cloth top surface when it is at the alignment position (where the pulley B indication mark “●” and the cover indication mark “●” are aligned).

   Note) When the presser feet have been adjusted in height, check that each needle lowers to the center of the presser foot hole.

4. Turn on the power switch and lower presser foot [1] with the lever.
4. Adjustment of Thread Trimmer

1. Bring fixed knife e into contact with spring pin [2] of needle plate base [1], and tighten the screw.
When attaching fixed knife [3], adjust the distance from the knife to hole [4] of the needle plate to 10 mm.

5. Thread Wiper Adjustment


2. If there is a difference in motion between needle bars No. 1 and No. 9 (No. 12 for BE-1201B-AC-PC), loosen four screws [4] and make an adjustment by moving thread presser base [5] in the direction of the arrow. Make sure that no interference will occur when pressure foot [6] is raised by the solenoid.


4. After the above steps are complete, check thread hook [2] for smooth movements. If the thread hook does not move smoothly, apply grease (Grease Tank BR2 (black)) to the gray part of thread guide solenoid base [10] and check its movements.

Note) • Care should be taken if the finger guard is inclined. If the finger guard in such a state is pushed excessively toward the needle at the time of color change, it may interfere with the presser foot. • Then make an adjustment in the crosswise direction by sliding bolt [9] of finger guard [8].

---

BE: 0901E·AC·PC • BE: 1201B·AC·PC

Chapter 10 Adjustment

BE-0901E·AC·PC • BE-1201B·AC·PC

10-9
6. Adjusting the Belt Tension

The belt tension is adjusted to the optimum tension at the time of shipment from the factory. However, as the belt is used, it becomes run in and may loosen around the machine pulley and motor pulley. Use the following procedure to check the belt tension.

Bring a push-pull into contact with belt [1]. Adjust the deflection of the belt to 8 mm when a 9.8 N pressure is applied. Loosen nut [2] and adjust nut [3] for proper deflection.

The machine operating direction is counterclockwise when seen from the machine pulley end.
Chapter 11  Error code list
## Chapter 11 Error code list

<table>
<thead>
<tr>
<th>Code</th>
<th>Error</th>
<th>Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-00</td>
<td>No error occurs.</td>
<td>This is not usually displayed.</td>
</tr>
<tr>
<td>E-01</td>
<td>E-01ERROR 01Either motor of main shaft, X- or Y-axis has locked.</td>
<td>Turn the power off and on once. If the same error occurs again, the area sensor is faulty.</td>
</tr>
<tr>
<td>E-02</td>
<td>Overtravel occurs during home position detecting movement.</td>
<td>Turn the power off and on once. If the same error occurs again, the area sensor is faulty.</td>
</tr>
<tr>
<td>E-03</td>
<td>The stop switch is pressed during home position detecting movement.</td>
<td>Press the to restart the home position detecting movement again.</td>
</tr>
<tr>
<td>E-04</td>
<td>Zero detecting movement out of range</td>
<td>Turn the power off and on once. If the same error occurs again, the home position sensor is faulty.</td>
</tr>
<tr>
<td>E-05</td>
<td>Needle stop position error</td>
<td>Adjust the pulley stop position (100 degrees) above the needle and press the.</td>
</tr>
<tr>
<td>E-06</td>
<td>Needle bar case position error</td>
<td>This is not usually displayed.</td>
</tr>
<tr>
<td>E-07</td>
<td>Needle bar case lock</td>
<td>Press the . If the same error occurs again, the color change mechanism is faulty.</td>
</tr>
<tr>
<td>E-08</td>
<td>Stop switch or emergency switch was pressed while the needle bar case is traveling.</td>
<td>This is not usually displayed.</td>
</tr>
<tr>
<td>E-09</td>
<td>X-axis home position detection error</td>
<td>Turn the power off and on once. If the same error occurs again, the X-axis mechanism is faulty.</td>
</tr>
<tr>
<td>E-0A</td>
<td>Thread breaking error</td>
<td>After passing through the thread, press the.</td>
</tr>
<tr>
<td>E-0B</td>
<td>Stop or emergency stop during sewing</td>
<td></td>
</tr>
<tr>
<td>E-0C</td>
<td>Insufficient bobbin thread</td>
<td></td>
</tr>
<tr>
<td>E-0D</td>
<td>The machine does not return to the home position.</td>
<td>This is not usually displayed.</td>
</tr>
<tr>
<td>E-0F</td>
<td>Undefined error</td>
<td></td>
</tr>
<tr>
<td>E-14</td>
<td>Y-axis home position error</td>
<td>Turn the power off and on once. If the same error occurs again, the Y-axis mechanism is faulty.</td>
</tr>
<tr>
<td>E-15</td>
<td>Stop error during SSP processing (when pressing the stop key while the hoop is moving)</td>
<td>Hoop movement restarts if you press .</td>
</tr>
<tr>
<td>E-16</td>
<td>Needle with specified number is out of movable area.</td>
<td>This is not usually displayed.</td>
</tr>
<tr>
<td>E-17</td>
<td>Speed Vol. No. is out of range.</td>
<td></td>
</tr>
<tr>
<td>E-1A</td>
<td>Destination coordinates error</td>
<td></td>
</tr>
<tr>
<td>E-1C</td>
<td>The machine stops during mask tracing.</td>
<td>Tracing is cancelled if the key is pressed when the machine is stopped during mask tracing. Press the key to continue tracing</td>
</tr>
<tr>
<td>E-1D</td>
<td>The machine stops while the needle is moving between patterns during repeat sewing.</td>
<td>This is displayed when the stop switch is pressed while the hoop is moving. Press the to move the hoop again. (It is necessary to press the again to start sewing.)</td>
</tr>
<tr>
<td>E-1F</td>
<td>Presser foot down error while searching for home position just after the power is turned on.</td>
<td>Press the . If the same error occurs again, adjust the presser foot switch.</td>
</tr>
</tbody>
</table>
### Chapter 11 Error code list

<table>
<thead>
<tr>
<th>Code</th>
<th>Error</th>
<th>Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-21</td>
<td>Hoop overhang (+X)</td>
<td></td>
</tr>
<tr>
<td>E-22</td>
<td>Hoop overhang (+Y)</td>
<td></td>
</tr>
<tr>
<td>E-23</td>
<td>Hoop overhang (+X, +Y)</td>
<td></td>
</tr>
<tr>
<td>E-24</td>
<td>Hoop overhang (-X)</td>
<td></td>
</tr>
<tr>
<td>E-25</td>
<td>Hoop overhang (+X, -X)</td>
<td></td>
</tr>
<tr>
<td>E-26</td>
<td>Hoop overhang (-X, +Y)</td>
<td></td>
</tr>
<tr>
<td>E-27</td>
<td>Hoop overhang (+X, -X, +Y)</td>
<td></td>
</tr>
<tr>
<td>E-28</td>
<td>Hoop overhang (-Y)</td>
<td></td>
</tr>
<tr>
<td>E-29</td>
<td>Hoop overhang (+X, -Y)</td>
<td></td>
</tr>
<tr>
<td>E-2A</td>
<td>Hoop overhang (+Y, -Y)</td>
<td></td>
</tr>
<tr>
<td>E-2B</td>
<td>Hoop overhang (+X, +Y, -Y)</td>
<td></td>
</tr>
<tr>
<td>E-2C</td>
<td>Hoop overhang (-X, -Y)</td>
<td></td>
</tr>
<tr>
<td>E-2D</td>
<td>Hoop overhang (+X, -X, -Y)</td>
<td></td>
</tr>
<tr>
<td>E-2E</td>
<td>Hoop overhang (-X, +Y, -Y)</td>
<td></td>
</tr>
<tr>
<td>E-2F</td>
<td>Hoop overhang (+X, -X, +Y, -Y)</td>
<td></td>
</tr>
<tr>
<td>E-31</td>
<td>Needle overhang (+X)</td>
<td></td>
</tr>
<tr>
<td>E-32</td>
<td>Needle overhang (+Y)</td>
<td></td>
</tr>
<tr>
<td>E-33</td>
<td>Needle overhang (+X, +Y)</td>
<td></td>
</tr>
<tr>
<td>E-34</td>
<td>Needle overhang (-X)</td>
<td></td>
</tr>
<tr>
<td>E-36</td>
<td>Needle overhang (-X, +Y)</td>
<td></td>
</tr>
<tr>
<td>E-38</td>
<td>Needle overhang (-Y)</td>
<td></td>
</tr>
<tr>
<td>E-39</td>
<td>Needle overhang (+X, -Y)</td>
<td></td>
</tr>
<tr>
<td>E-3C</td>
<td>Needle overhang (-X, -Y)</td>
<td></td>
</tr>
<tr>
<td>E-41</td>
<td>Invalid start-up error</td>
<td>Turn the power off and on once.</td>
</tr>
<tr>
<td>E-42</td>
<td>XY movement error</td>
<td>Press the</td>
</tr>
<tr>
<td>E-43</td>
<td>Slave I/F EEPROM read error</td>
<td>Turn the power off and on once. If the same error occurs again, the main PC is faulty.</td>
</tr>
<tr>
<td>E-A1</td>
<td>Spindle motor lock</td>
<td>Press the  If it occurs frequently, the main shaft mechanism is faulty.</td>
</tr>
<tr>
<td>E-A5</td>
<td>Spindle motor CPU error</td>
<td></td>
</tr>
<tr>
<td>E-A6</td>
<td>Main shaft motor CPU communication command error</td>
<td>This is not usually displayed.</td>
</tr>
<tr>
<td>E-A7</td>
<td>Main shaft motor CPU send/receive error</td>
<td></td>
</tr>
<tr>
<td>E-A8</td>
<td>Main shaft stop position signal error</td>
<td>Adjust the pulley stop position (100 degrees) above the needle and press the  If the error occurs frequently, the parts related to the main shaft stop position sensor are faulty.</td>
</tr>
<tr>
<td>E-A9</td>
<td>Spindle CPU parameter error</td>
<td>This is not usually displayed.</td>
</tr>
<tr>
<td>E-C1</td>
<td>Area over during embroidering</td>
<td>Set the embroidering area again on the panel.</td>
</tr>
<tr>
<td>E-C2</td>
<td>Wiper out error</td>
<td>If the wiper is tangled with a thread, remove it. Press the</td>
</tr>
<tr>
<td>E-C3</td>
<td>Embroidering data buffer empty</td>
<td></td>
</tr>
<tr>
<td>E-C9</td>
<td>Embroidering start error</td>
<td>This is not usually displayed.</td>
</tr>
<tr>
<td>E-CA</td>
<td>No sewing permission</td>
<td></td>
</tr>
</tbody>
</table>
## Chapter 11 Error code list

<table>
<thead>
<tr>
<th>Code</th>
<th>Error</th>
<th>Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-CB</td>
<td>Spindle rotation speed error</td>
<td>Press the ( ) to cancel the error and press the ( ) if the same error occurs again, there is a possibility that the spindle is overloaded.</td>
</tr>
<tr>
<td>E-CD</td>
<td>Speed command can not be received.</td>
<td>Turn the power off and on once. If the same error occurs again, the main PCB is faulty.</td>
</tr>
<tr>
<td>E-E3</td>
<td>Cooling fan motor stop.</td>
<td>Turn off the power and check the fan harness. Turn on the power again. If the same error occurs again, the fan or the main PCB is faulty.</td>
</tr>
<tr>
<td>E-E5</td>
<td>Over-run error during interfacing to main PCB CPU</td>
<td></td>
</tr>
<tr>
<td>E-E6</td>
<td>Framing error during interfacing to main PCB CPU</td>
<td></td>
</tr>
<tr>
<td>E-E7</td>
<td>Parity error during interfacing to main PCB CPU</td>
<td></td>
</tr>
<tr>
<td>E-E8</td>
<td>Receiving time up error during interfacing to main PCB CPU</td>
<td></td>
</tr>
<tr>
<td>E-E9</td>
<td>Send/Receive inconsistent error during interfacing to main PCB CPU</td>
<td></td>
</tr>
<tr>
<td>E-EA</td>
<td>ACK code receiving error during interfacing to main PCB CPU</td>
<td></td>
</tr>
<tr>
<td>E-EB</td>
<td>Send/Receive ID code error during interfacing to main PCB CPU</td>
<td></td>
</tr>
<tr>
<td>E-EC</td>
<td>Send data checksum error during interfacing to main PCB CPU</td>
<td></td>
</tr>
<tr>
<td>E-ED</td>
<td>Data empty error during interfacing to main PCB CPU</td>
<td>This is not usually displayed.</td>
</tr>
<tr>
<td>E-EE</td>
<td>Receiving error on interface</td>
<td></td>
</tr>
<tr>
<td>E-F1</td>
<td>Send time up error</td>
<td></td>
</tr>
<tr>
<td>E-F2</td>
<td>Request-to-waiting time up error</td>
<td></td>
</tr>
<tr>
<td>E-F3</td>
<td>Request-to-recvie time up error</td>
<td></td>
</tr>
<tr>
<td>E-F4</td>
<td>Receive command error</td>
<td></td>
</tr>
<tr>
<td>E-F5</td>
<td>NACK code receiving error</td>
<td></td>
</tr>
<tr>
<td>E-F6</td>
<td>Data requested for needle position can not be returned.</td>
<td></td>
</tr>
<tr>
<td>E-F7</td>
<td>It is not receive command for the request one.</td>
<td></td>
</tr>
<tr>
<td>E-F8</td>
<td>PRE code error</td>
<td></td>
</tr>
<tr>
<td>E-F9</td>
<td>No applicable command</td>
<td></td>
</tr>
<tr>
<td>E-FA</td>
<td>Interface receive data sum check error</td>
<td></td>
</tr>
<tr>
<td>E-FB</td>
<td>Send time up error</td>
<td></td>
</tr>
<tr>
<td>E-FF</td>
<td>No status is returned from main shaft CPU.</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 12  Troubleshooting

If there is any indication of trouble with the machine, check and correct as described in the table. If the trouble cannot be corrected, turn off the power and contact your distributor for corrective actions.
# Mechanical Section

<table>
<thead>
<tr>
<th>Problem</th>
<th>Check point</th>
</tr>
</thead>
</table>
| **Thread breakage** | • Is the machine properly threaded?  
• Is thread tension too high?  
• Is the rotary hook assembly clogged?  
• Is there thread in the bobbin?  
• Is the needle bent?  
• Is there a rough edge or flaw on the needle plate, rotary hook, or bobbin case that might cut the thread?  
• Is the needle installed correctly (direction, angle, etc.)?  
• Is the presser foot in contact with the material?  
• Are the thread thickness and needle size correct?  
• Is a thread with right-hand twist being used? (If such a thread is used, replace with a thread with left-hand twist.)  
• Is there any adhesive on the needle?  
• Is the material tension too weak?  
• Is there too much play between the outer rotary hook and inner rotary hook?  
• Does the outer rotary hook turn smoothly?  
• Is the clearance between the rotary hook stopper and the rotary hook adjusted correctly?  
• Does the thread come out from the bobbin case smoothly? |
| **Needle (presser foot) interference with embroidery hoop** | • Is the embroidery hoop too small?  
• Check the size and needle start position in the sewing data. |
| **Needle breakage** | • Is the needle attached correctly (direction, height, etc.)?  
• Is the needle bent?  
• Is the rotary hook attached correctly?  
• Is the timing set correctly?  
• Is there any backlash with the needle bar case (back/forth and right/left)?  
• Is the rotary hook stopper correctly attached to stop the rotary hook?  
• Is the needle size correct and the tip sharp?  
• Does the thread pass through the hole center of the presser foot? |
| **Not embroidered properly** | • Is the material edge caught in the machine? (Are embroidery hoop and other related parts operating correctly?)  
• Is the material stretched properly?  
• Is thread tension proper?  
Does the lower thread come out smoothly? |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Check point</th>
</tr>
</thead>
</table>
| Machine operation abnormal | • Is any set screw of the rotary encoder loosened?  
• Is any set screw of the machine pulley loosened?  
• Is any set screw of the machine motor pulley loosened?  
• Is embroidery data normal?  
• Is the XY carriage belt damaged?  
• Are any set screws for the XY pulley loosened?  
• Are any set screws for the coupling of the XY pulse motor loosened? |
| Upper shaft locks at a certain point in one cycle | • Is the thread take-up stopped due to interference with the upper case cover?  
[Adjustment]  
Loosen the hexagon socket head cap screw of the thread take-up operating lever and adjust the take-up movable range.  
Tighten it securely afterwards.  
• Are the needle bar clamp and the top dead center stopper positioned correctly? |
| Upper shaft pulley does not turn. | • Is the presser foot lifted at a retract position when the power is turned on?  
Lower the presser foot using the lever. |
| Stitches cannot be made. | • Is the needle attached properly?  
• Is the timing of the needle and rotary hook correct? |
# Electrical Section

## Cautions
- Be sure to turn off the power of the machine and unplug the power cord before checking cable connections.
- When you check connection of the cables as instructed in this manual, also check connection and continuity between connectors.
- Carry out items described in the "Measures" section in order of appearance.
- Some checks and replacement works can be conducted only by repair people. In such cases, contact your dealer.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Measures</th>
</tr>
</thead>
</table>
| The machine does not operate even if the power is turned on. | • Is the power cord of the machine plugged in?  
→ Plug in the power cord.  
• Is the connector in the control box connected?  
→ Connect it after checking the types and colors of the connectors.  
• Is fuse F1 or F5 on the power PCB in the control box blown?  
→ Replace the fuse with a new one. If the fuse is blown again, something is faulty. Check to see if the wiring is correct. Replace the control box with a new one. |
| The machine does not operate even if the power is turned on.  
The message, "Release stop SW to operate!", is displayed on the panel. | • Is the stop switch (Option) turned on?  
→ Reset the stop switch. |
| An overtravel error occurs. | • Is the frame within the cap frame area?  
→ Move the frame within the cap frame area and turn on the power.  
• Check to see if the signal of the X area sensor turns ON and OFF in PORT test mode.  
→ When the signal does not change, refer to the block diagram showing the cable connections and check to see if connection from the X cap sensor to the main PCB is proper. Replace the X cap sensor with a new one. |
| The needle stop position error occurs. | • Is the pulley manually turned and out of the stop angle?  
→ Turn the pulley, adjust the needle at the stop position, and reset the error.  
• Check the signal of the stop position sensor in the encoder test mode.  
→ Refer to the adjustment or cable connection block diagram and check connection from the needle position detention sensor to the main PCB. Replace the needle position detection sensor with a new one.  
• Is the main shaft brake solenoid operating?  
→ If not, refer to the block diagram showing the cable connections and check to see if the connections from the brake solenoid to the power PCB and from connector P27 of the power PCB to connector P1 of the main PCB are proper.  
• Are there any problems with the main shaft mechanism? (i.e., The screw of the main shaft pulley is loose.) |
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Measures</th>
</tr>
</thead>
</table>
| The needle bar case lock error occurs. | • Is the INDEX motor rotating?  
→ If not, refer to the block diagram showing the cable connections and check to see if connection from the INDEX motor to the main PCB is proper.  
Check the resistance values of pins 1 and 2 and pins 3 and 4 at the connector section of the INDEX motor. The normal resistance value is approximately 10 Ω.  
→ If it is not normal, replace the INDEX motor with a new one. Also replace the main PCB with a new one.  
• Manually turn the color change pulley.  
→ If it is abnormally heavy, adjust the color change mechanism and the needle bar case.  
• Start the machine after invalidating its initial setting and enter the needle bar case test mode. Do figures on the panel change when the color change pulley is manually turned?  
→ If not, check to see if connection from the needle bar position sensor to connector P7 of the head PCB is proper.  
• Replace the needle bar position sensor (potentiometer) with a new one.  
• Replace the head PCB with a new one. |
| X-axis or Y-axis home position detection error occurs. | • Was the XY carriage moving?  
→ If so, refer to the block diagram showing the cable connections and check to see if connection from the X and Y area sensor to the main PCB is proper.  
• Was the XY motor rotating?  
→ If so, check the XY carriage mechanism.  
• If the XY motor is not rotating, refer to the cable connection block diagram and check to see if connection from the XY motor to the main PCB is proper. |
| The thread breakage error frequently occurs although thread is not broken. | • Enter the needle bar case test mode and turn the thread breakage sensor pulley while switching the needle bar from number 1 in ascending order.  
→ If there is no problem, lower the thread breakage sensitivity value of the machine controller. (The standard value is 0.)  
• Check connection from the thread breakage sensor PCB to the head PCB if the number does not blink.  
• Replace the thread breakage sensor PCB with a new one. |
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Measures</th>
</tr>
</thead>
</table>
| The main shaft motor lock error occurs.      | • Enter the encoder signal mode and manually turn the main shaft pulley.  
  → If it is abnormally heavy, the main shaft mechanism is faulty.  
  • Does the main shaft motor rotate at all when the error occurs?  
  → If it does not rotate at all, check fuse F1 and F5 on the power supply PCB in the control box. Refer to the block diagram showing the cable connections and check to see if connection from the main shaft motor to the main PCB is proper. Also check connection of connectors P15 and P16 of the main PCB and connectors P1 and P2 on the power PCB in the box, and connection from connector P14 of the main PCB to the 14v terminal of the power transformer.  
  • Manually turn the main shaft pulley in the encoder signal test mode and check to see if the stop position signal and encoder signal are proper.  
  → If either of the signals does not change, refer to the block diagram showing the cable connections and check to see if connection from the encoder and stop position sensor to the main PCB is proper. |
| E-A8 frequently occurs.                      | • In the encoder signal test mode, manually turn the main shaft pulley and check to see that the stop position signal is correct.  
  → If the signal does not change, refer to the cable connection block diagram and check to see if connection from the stop position sensor to the main PCB is proper. |
| Wiper out error occurs.                     | • Does the wiper remain projected?  
  → If the wiper is tangled with a thread, remove it. If the wiper does not return smoothly, adjust it.  
  • Enter the solenoid test mode and operate the wiper solenoid. Check the icon on the panel.  
  → If the panel is not changed, check to see if connection from the wiper sensor to the head PCB is proper. Replace the wiper sensor with a new one. Replace the head PCB with a new one. |
| Main shaft rotation speed error occurs.     | • Enter the encoder signal test mode and manually turn the main shaft pulley.  
  → If it is abnormally heavy, the main shaft mechanism is faulty.  
  • Refer to the block diagram showing the cable connections and check to see if connection from the main shaft motor to the main PCB is proper. Also check the connection from connectors P14 of the main PCB to the 14v terminal of the power transformer. |
| Exhaust fan motor stops.                    | • Refer to the block diagram showing the cable connections and check to see if connection of connector P22 of the main PCB in the control box is proper.  
  • Check fuse F3 on the power supply PCB.  
  → If it is blown, replace it with a new one. If it becomes blown again, the 24v system circuit is faulty. |
| ERROR E5 to ERROR FF frequently occur.      | • Replace the main PCB with a new one.                                                                                                                                                                                                                                   |
| All solenoids of head do not operate.       | • Refer to the block diagram showing cable connections and check fuse F2 on the power supply PCB.  
  → If it is blown, replace it with a new one. The 60v circuit is faulty if the fuse is blown immediately after turning on the power even after replacing the fuse. |
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jump solenoid does not operate.</td>
<td>• Check to see if connection from the jump solenoid to connector P10 of the head PCB is proper.</td>
</tr>
<tr>
<td></td>
<td>• Check the resistance value of the jump solenoid which does not operate with the connector section. The normal resistance value is approximately 185Ω.</td>
</tr>
<tr>
<td></td>
<td>→ If it is faulty, replace the solenoid with a new one. In this case, the head PCB may also be faulty. Also replace the head PCB with a new one if it does not operate properly even after replacing the solenoid.</td>
</tr>
<tr>
<td></td>
<td>• Replace the head PCB with a new one.</td>
</tr>
<tr>
<td>Wiper solenoid does not operate.</td>
<td>• Check to see if connection from the wiper solenoid to connector P11 of the head PCB is proper.</td>
</tr>
<tr>
<td></td>
<td>• Check the resistance value of the wiper solenoid which does not operate with the connector section. The normal resistance value is approximately 28Ω.</td>
</tr>
<tr>
<td></td>
<td>→ If it is faulty, replace the solenoid with a new one. In this case, the head PCB may also be faulty. Also replace the head PCB with a new one if it does not operate properly even after replacing the solenoid.</td>
</tr>
<tr>
<td></td>
<td>• Replace the head PCB with a new one.</td>
</tr>
<tr>
<td>Pickker solenoid does not operate.</td>
<td>• Check to see if connection from the pickker solenoid to connector P8 of the head PCB is proper.</td>
</tr>
<tr>
<td></td>
<td>• Check the resistance value of the pickker solenoid which does not operate with the connector section. The normal resistance value is approximately 426Ω.</td>
</tr>
<tr>
<td></td>
<td>→ If it is faulty, replace the solenoid with a new one. In this case, the head PCB may also be faulty. Also replace the head PCB with a new one if it does not operate properly even after replacing the solenoid.</td>
</tr>
<tr>
<td></td>
<td>• Replace the head PCB with a new one.</td>
</tr>
<tr>
<td>Thread trimmer solenoid does not operate.</td>
<td>• Check to see if connection from the thread trimmer solenoid to connector P20 of the main PCB is proper.</td>
</tr>
<tr>
<td></td>
<td>• Check the resistance value of the thread trimmer solenoid which does not operate with the connector section. The normal resistance value is approximately 27Ω.</td>
</tr>
<tr>
<td></td>
<td>→ If it is faulty, replace the solenoid with a new one. In this case, the main PCB may also be faulty. Also replace the main PCB with a new one if it does not operate properly even after replacing the solenoid.</td>
</tr>
<tr>
<td></td>
<td>• Replace the main PCB with a new one.</td>
</tr>
<tr>
<td>Pressor foot solenoid does not operate.</td>
<td>• Check to see if connection from the pressor foot solenoid to connector P20 of the main PCB is proper.</td>
</tr>
<tr>
<td></td>
<td>• Check the resistance value of the pressor foot solenoid which does not operate with the connector section. The normal resistance value is approximately 80Ω.</td>
</tr>
<tr>
<td></td>
<td>→ If it is faulty, replace the solenoid with a new one. In this case, the main PCB may also be faulty. Also replace the main PCB with a new one if it does not operate properly even after replacing the solenoid.</td>
</tr>
<tr>
<td></td>
<td>• Replace the main PCB with a new one.</td>
</tr>
</tbody>
</table>
Chapter 13
Connection and Installation of Optional Equipment
1. Attaching Bobbin Winder

**Mounting method**

1. Loosen four screws [1] and remove table (L) [2].


## Winding lower thread

1. Turn on the power switch.

2. Fit bobbin [1] to the bobbin winder shaft [2].

3. Pass a thread through thread guide [3].

4. Wind the thread around bobbin [1] several times in the direction of the arrow.

5. Press bobbin hold [4].
   
   Note) • If the thread cannot be wound evenly, loosen screw [5] and move thread guide [3] from side to side for adjustment.
   
   • To wind more thread around the bobbin, loosen screw [5] and shift bobbin hold [4].

6. After winding is finished, remove the bobbin from the bobbin winder shaft and trim the thread using tread trimmer [7].

   Note) • If the thread passed though thread guide [3] comes off, loosen knob [8]. If the thread is wound loosely, tighten knob [8].

   • If circuit protector [9] is activated, the bobbin winder motor does not rotate. Wait for a while until the motor cools and press the circuit protector. (If the motor is still hot, the pressed circuit protector will come out.)